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Important Notice

Please take notice of the following remarks when installing SIMLUCIA.
1. SIMLUCIA has been developed for United Nations Environment Programme,
Caribbean Regional Co-ordinating Unit, Kingston Jamaica (UNEP CAR/RCU) as
part of the MOU between UNEP and CIMAS, Miami, Fl, US. SIMLUCIA has been
developed by RIKS bv, P.O. Box 463, 6200 AL Maastricht, The Netherlands. Part of
the modelling work has been carried out by Prof. Roger White, Geography
Department, Memorial University, St. John’s, Nfld, A1C 5S7 Canada.
2. If you have on your machine other RIKS applications, such as: GEONAMICA®, the
ISLAND Demo, the CELLCITY Demo, RAMCO, LOKMod, WadBOS, or earlier
versions of SIMLUCIA, then put the SIMLUCIA files in a dedicated directory different
from the one(s) that contain(s) any of the other applications. Do not interchange files
between the different applications as files may have the same names but different
contents.
3. RIKS is constantly trying to improve its applications. It is our policy to send you the
most recent version of the programs and manuals available. However, as a result, you
may receive an application that is slightly different from the one described in the
manual. Do not hesitate to contact us if this would cause you any problems.
4. The RIKS Demos are curtailed versions of more elaborate software products. Each of
the Demos is conceived to allow you to get a good understanding of the full software
product. If you are interested in a demonstration of the full version, you are welcome
to contact us.
5. Neither software development with the tools provided in the SIMLUCIA package nor
the application of the SIMLUCIA package to a case study is permitted.
Software or application development and further usage or marketing of the SIMLUCIA
package will only be accepted following the purchase of a full version of the package.
Enjoy our Demos and please return your comments to us.
Inge Uljee, Guy Engelen, Roger White
RIKS
P.O. Box 463
6200 AL Maastricht
The Netherlands
Tel. 31-43-388.33.32
Fax. 31-43-325.31.55
e-mail:guy@riks.nl
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1.

Introduction

This report covers the activities of RIKS in Phase 2 of the UNEP project ’Vulnerability
Assessment of Low-lying Coastal Areas and Small Islands to Climate Change and Sea
Level Rise’.
The long term objectives of this project are to develop a methodology and operational
procedure applicable on the level of the individual coastal country or island (1) to
describe and analyse the impacts of climate change on their territory, their ecosystems,
their social systems and their economic activities, and (2) to provide instruments or tools
to design, explore and evaluate policy measures and policy interventions to prevent or
alleviate undesirable impacts.
Phase 1 of the project proposed a generic modelling methodology and decision support
system judged to be capable of fulfilling, at least partially, both requirements posed in
the objectives. More than being a theoretical exercise, the project produced a
demonstrator version of the decision support system developed.
The specific objectives of Phase 2 of the project are to apply the modelling methodology
and decision support system to St. Lucia, West Indies and to adapt them to the extent
required.

1.1.

Summary of the work carried out in Phase 1
Climate change in the Wider Caribbean Region is expected to have an important impact
on the physical, environmental, social and economic systems (Maul, 1993). Socioeconomic systems in the region are already stressed considerably due to demographic,
economic and environmental factors, and climate change will exacerbate this situation.
Hence, formal instruments to study the effects of climate change on socio-economic
systems require realistic representations of their actual state and of the mechanisms that
will cause them to change in the future. Their temporal and spatial dynamics should be
well represented, because climate change is affecting socio-economic systems through
mechanisms at very different geographical scales: at the Macro-scale causing changes in
the exchanges with the world system through changed demands, exports, imports and
migrations; and at the Micro-scale causing the relocation and possible disappearance of
activities.
With a view to realistically describe the effects of climate change on socio-economic
systems we developed an explicitly dynamic (temporal) and spatial modelling framework
operating at two geographical levels: the Macro-level describes the macro-economic and
long-range spatial interactions, and the Micro-level describes the short-range interactions
and location choices. This modelling framework has been applied to and tested on a
theoretical, prototypical, island (named ISLAND) with characteristics typical of existing
small Caribbean islands. At the Macro-level, ISLAND is modelled as a single region --as
one point in space interacting with the external world. Hence, a single set of linked
dynamic equations generates the evolution in time of the integrated socio-economic and
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environmental systems. The growth
coefficients thus calculated are fed
into a cellular model, operating on the
Micro-level, which allocates the socioeconomic growth to island cells of 500
by 500 meter.
This allocation
mechanism is based on Micro-level
spatial interactions specified in
cellular automata rules and based on
physical suitability measures retrieved
from a GIS. The cellular model will
return the results of the allocation to
the Macro-level, thus guaranteeing the
full coupling of the macro and micro
scales.

Figure 1: A modelling framework consisting of coupled
models at the Macro-level and the Micro-level.

At the Macro-level essentially three
coupled sub-systems are modelled: the
natural, social, and economic subsystems. The proposed modelling
framework allows for different types
of mathematical representations of
each of these sub-systems, thus
allowing for a more or less detailed
description of certain aspects of the
sub-systems. In the first phase of the
project we have selected model
representations that fit the application
of the modelling framework to the
hypothetical small island. It reflects
the archetype nature of the work and
leaves room for a number of
improvements. The economic subsystem is modelled by means of a
highly aggregated input-output model,
coupled with the demographic model
(through a wealth indicator and
household demands), with the natural
system (climate changes influence
external demand) and with the Microlevel via a land density expression
(activities require space).

The economy is aggregated into five sectors. In the social sub-system the ISLAND
demography is modelled as a single population group growing as the result of births,
deaths, and migration. The birth rate is specified to follow a long term trend, while
mortality and migration rates depend on both forecasted long term structural trends, and
on the well-being of the island population as indicated by the employment participation
rate. The natural sub-system consists of a set of linked relations representing the
expected change in time of sea level and temperature, and their effects on the loss of
land, on precipitation, storm frequency, and external demands for services and products.
Later, the natural sub-system could be further developed to include a description of the
growth of natural systems such as coral reefs, mangroves, and beaches. The model
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provides the slots to plug in such modules, but further research will be required to
develop and implement them.
At the Macro-level, the model calculates the changes in employment per sector and the
growth of the population. New jobs and new people will require space to support their
residential and economic activities. In the model the translation of economic and
residential activity into space is performed by means of the land density expression. The
land density is a function of the total amount of land available, the suitability of that land
for the activities carried out, and the land (and its suitability) already occupied.
Generally speaking, land density will increase if land is getting scarce. But it will
decrease if the land occupied is getting marginal for use by the specific activity. The
total amount of land required by each activity is used as an input to the Micro-level part
of the model.
More than in the Macro-scale representation, the principle mechanism underlying the
Micro-scale dynamics is the fact that socio-economic activities will interact with one
another in geographical space. It is a well documented phenomenon in regional
economics and is common to concepts such as economies of scale, agglomeration
advantages, distance decay, push and pull forces. It translates the fact that activity X
does not flourish in the neighbourhood of activity or feature Y, while Z does very well
near Y. These push and pull forces are expressed in the cellular model by means of
attraction-versus-distance functions for each pair of activities or land-uses modelled. But
this functional appropriateness of a cell is not by itself sufficient to decide the likelihood
that the cell will be occupied by one or the other activity. Its intrinsic physical suitability
will also have to be right. The physical suitability of a cell is an aggregate measure
calculated from a number of physical indicators (and may include infrastructural and
legislative factors as well). These calculations are standard operations in state of the art
(commercially available) GIS packages. Hence the coupling of the modelling framework
with a GIS package is envisaged.
It is by means of Cellular Automata rules that we calculate the changing land-use on the
Micro-level. Rules are applied hierarchically. The highest priority is given to user
interventions, including the forced location of an activity in a specific area, or the
development of an area for a specific use, etc. The next highest priority involves the
elevation of a cell relative to the sea level. These rules decide on the total amount of
land available for the different activities and on the physical suitability of such land. The
lowest priority is for rules that calculate the aptness of a cell to receive a specific activity.
This aptness is a function of the physical suitability of the cell and the activities already
present in its neighbourhood.
The model thus defined is the core element of the DSS (Decision Support System) that
we began to implement. In the DSS the model is complemented with user-friendly and
interactive software tools which make it very easy to use and which facilitate the
decision making process.
Phase 1 of the project involved the application and testing of the modelling framework
on the basis of a theoretical application only. It suggested that the framework would be
applied to a real case and that a thorough validation and calibration would be carried
out.
The results of phase 1 have been documented in Engelen et al., 1993a, Engelen et al.,
1993b and Engelen et al., 1995. The demonstrator developed in phase 1, called ISLAND
Demo, can be obtained from RIKS, or, for those having access to Internet, can be
downloaded from the RIKS’ homepage: http://saturn.matriks.unimaas.nl
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1.2.

Phase 2: SIMLUCIA
The remainder of this report deals with the second phase of the project ’Vulnerability
Assessment of Low-lying Coastal Areas and Small Islands to Climate Change and Sea
Level Rise’, which mainly involves the application of the modelling and decision
framework to the case of St. Lucia. The resulting model and software system has been
given the name SIMLUCIA. In Chapter 2 the development and implementation of the
models at the Macro-level is discussed, while Chapter 3 gives more details on the Microlevel models. Chapters 4, 5, 6 and 7 cover the contents of the user manual for SIMLUCIA,
and finally Chapter 8 demonstrates the use of SIMLUCIA in a policy context.

Page 10

2.

Macro-Level Dynamics

The Macro-level model (Figure 2) essentially models three coupled sub-systems each
represented by sets of linked variables: the natural sub-system, the social sub-system and
the economic sub-system.

Figure 2: Schematic representation of the Macro-level of the model showing the loops linking the
natural, the social and economic sub-systems.

2.1.

The Natural sub-system
The natural sub-system consists of a set of linked relations expressing the change in time
of temperature and sea level, and the effects of these on precipitation, storm frequency
and external demands for services and products from St. Lucia. The hypothesis is made
that climate change only affects the external demand for products produced in St. Lucia
thus expressing changing world markets as well as the manner in which the island’s
products and services is perceived in the external world (e.g. by possible clients, tourists
or investors). In this version of the model these relations are entered directly by the user
and either represent state of the art knowledge, outputs of other models including global
circulation models, climatic change models and greenhouse gas models, or the scenarios
or sets of hypotheses with which the model is run.

2.1.1

Climate
definition:
The expressions used in the Climate MBB1 assume a simple and direct relation between
two variables. However, the definition of changes in precipitation and storm frequency

1

The acronym MBB stands for Model Buiding Block and refers to a sub-model. (See also Annex A.)
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for example, as a function of temperature only is a strong simplification of reality. In
more elaborate versions of the model, such relations could be replaced by dedicated submodels capable of describing them at a deeper, causal level. Similarly, the model of the
Natural sub-system could include a description of the growth of natural systems such as
coral reefs, mangroves, sea grasses, riverine systems and beaches.
mathematical formulation:

Tt = f T ( t )
Lt = f L ( t )

Pt = f P (Tt )

Ft = f F (Tt )

[

]

Ei , t = ei , t 1 + f (Tt ) + f ( Pt ) + f ( Ft ) )
E tourism,t = etourism,t
with:
t
f()

E i ,t
Tt
Lt
Pt
Ft
N beach ,t
ei ,t

α
β

(

1 − β exp − αN beach ,t

(

)

1 − β exp − αN beach ,t =0

)

[1 + T

t

+ Pt + Ft ]

time
function of
Vector of sectoral external demand; [million EC$]
Temperature change; [Celsius]
Sea level change; [feet]
Precipitation change; []
Storm frequency change; []
Number of beach cells; [cells]
Vector of projected sectoral external demand ceteris paribus; [million EC$]
Resilience of tourism industry; []
Relative importance of beach tourism in total tourism industry; []

calibration information:

Figure 3: Most relations of the natural sub-system are defined as tables. The figure shows on the
left the relation between time and temperature change and on the right the effect of temperature
change on storm frequency.
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The relations used in SIMLUCIA are pure hypothesis expressing how the economy could
be influenced by climate change. Some general trends of these expressions have been
discussed with the scientists and members of the UNEP/IOC Task Team on the
Implications of Climatic Change in the Wider Caribbean Region. These trends are good
estimates for the St. Lucian situation, without them being scientifically proven. They
generally reflect the dependency of the agriculture and the tourism sector on the actual
climatic conditions. The user is free to correct or replace the hypotheses with better
information if it is available, or he can experiment with other hypotheses in order to find
out how different climate related scenarios would (possibly) affect the St. Lucian
economy.
Part of the natural sub-system concerns a measure of the physical and environmental
suitability (or aptness) of each Micro-level region (called cells in the cellular model) of
St. Lucia for receiving one of the activities modelled. This information is available from
the GIS (Geographical Information system) and its digitised maps. Changing sea level
will cause the loss (or gain) of low-lying coastal areas and will cause the total available
area to shrink (or to grow). This mechanism of losing or gaining land is modelled in the
Micro-level cellular automata model and is described in more detail in Chapter 3. Losing
or gaining land will affect the total suitability of the land area and will put more or less
stress on the land used by the different economic activities. This effect is expressed by
means of the concept of land density and explained under that heading in this chapter.
Hence, broadly speaking, the natural sub-system will translate the changes in temperature
and sea level into changes in the total land area, changes in the suitability of that land
area and in changed external demands for goods produced on the island.
2.1.2

Beach loss
definition:
Changing sea level will cause the loss (or gain) of beach area. This sub-model expresses
the fact that beach area is a very important asset for the tourism industry. Hence, that the
loss of beach might damage the industry a great deal. This is certainly the case for St.
Lucia where tourism is mainly beach related and where the total beach area is limited. In
the event that due to climate change beaches would disappear rapidly, St Lucia will
quickly lose its image in the outside world and gradually the demand for tourism would
fall.
mathematical formulation:

E tourism,t = etourism,t

(

1 − β exp − αN beach ,t

(

)

1 − β exp − αN beach ,t = 0

)

[1 + T + P + F ]
t

t

t

with:

E tourism,t
Tt
Lt
Pt
Ft
N beach ,t

External demand for tourism; [million EC$]
Temperature change; [C]
Sea level change; [feet]
Precipitation change; []
Storm frequency change; []
Number of beach cells; [cells]

etourism,t Projected external demand ceteris paribus for tourism; [million EC$]

α
β

Resilience of tourism industry; []
Relative importance of beach tourism in total tourism industry; [%]
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calibration information:

y=

(

1 − β exp − αN beach ,t

(

)

1 − β exp − αN beach ,t = 0

)

The two parameters in the expression take into consideration the effect of both (1) the
relative importance of beach tourism in the total tourism industry (parameter β ) and (2)
the sensitivity of the industry to the phenomenon of a disappearing beach (parameter α ).
In the graph underneath, three cases, representing different combinations of α and β ,
are shown. Generally speaking, an old, well established or rich tourism industry will do
whatever is in its power to prevent itself from vanishing (Case 2), while a young or poor
industry does not have the possibilities to do so (Case 1). Case 3 shows the trend of the
relation with the parameter values used for St. Lucia. Note however that the initial (at
t=0) number of beach cells in St. Lucia is only 34.

1.6
Demand for tourism (y)

1.4
1.2
1
0.8
0.6
0.4
0.2
0
0

50

100

150

200

250

300

350

Beach cells at time t
Case 1

α
β
Beach Cells at t=0

Case 1
0.01
0.9
100

Case 2

Case 2
0.05
0.6
100

Case 3

Case 3
0.01
0.6
100

default values:
For St. Lucia, the values for the parameters are as follows:
α = .05; β = .90;
these values reflect the fact that the tourism industry depends largely (90%) on the
presence of beaches, but, that it has a high level of resilience to counteract the effects of
beach degradation. In other words, it can afford to an extent beach nourishment or beach
protection programmes.
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2.2.

The Social sub-system
The social sub-system describes the demography of St. Lucia and the social well-being of
its population. The demography is modelled as a single population group growing
exponentially as the result of births, deaths and migrations. The social well-being is
expressed as the employment participation rate, meaning the proportion of people having
a paid job.

2.2.1

Population growth
definition:
This sub-model calculates the population growth in St. Lucia. The population is growing
exponentially as the result of births, deaths and migrations. The mortality rate and
migration rate both have a structural component and an economic component. The
structural component expresses the long term structural change which is valid for St.
Lucia or the larger region of which it is part. It represents long term trends set in motion
as a result of family planning policies, education, health care programs, etc. It reflects
for instance improving (or worsening) living conditions that gradually penetrate the area
(and affect the mortality rate), traditional migration trends and general evolution of the
well-being of the neighbouring countries (which affect the migration flows). Grafted on
this is a socio-economic component expressing improved living conditions and economic
prosperity in St. Lucia itself.
mathematical formulation:

bbt = f b ( t )

dd t = f d (t )
mmt = r 4 +

[1 + exp(− r 3(u − u ))]
t =0

t

2

[1 − r5 exp(u

t

] −1

− ut = 0 )

[1 − r5]

∆pt = pt × (bbt − dd t − mmt )
pt +1 = pt + ∆pt
with:
pt

bbt

ddt
mmt
Xi,t
ut

fb (t)
f d (t )

r3
r4
r5

Total population; [persons]
Birth rate; [1/1000]
Mortality rate; [1/1000]
Migration rate; [1/1000]
Vector of sectoral employment; [persons]
Wealth or employment participation rate; []
Structural reproduction rate; [1/1000]
Structural mortality rate; [1/1000]
Variable mortality rate; [1/1000]
Structural migration rate; [1/1000]
Variable migration rate; [1/1000]

calibration information:
expression:

dd t = f d (t )

[1 + exp(− r 3(u − u ))]
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t

2

t =0

The total mortality rate is the sum of a structural component (parameter f d ( t ) ) and a
component reflecting the wealth of the population (parameter r3). The graph shows
different curves for different hypothesis concerning the latter.
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f d (t )

Case 1
7
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7
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7

r3

0.5
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mmt = r 4 +

expression:

[1 − r5 exp(u

t

] −1

− ut = 0 )

[1 − r5]
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Total Migration Rate
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Case 3

1.5

Case 1
-5
0.6

r4
r5

Case 2
1
0.6

Case 3
5
0.9

Total migration rate is the sum of a structural component (parameter r4) and a
component reflecting the wealth of the population (parameter r5). The figure shows the
curves reflecting different cases.
default values:
The values used for St. Lucia have been calculated from the Annual Statistics Digest
1991 and personal communications from the Government Statistics Department.
2.2.2

Population
definition:
In SIMLUCIA, the assumption is made that there will be a growing concentration of the
population in urban areas. There is however not an expression that will calculate the
degree of urbanization on the basis of demographic or economic pressure. Rather, in this
version of the model, the proportion of the population living in urban areas is read in as a
scenario defined by the user.
mathematical formulation:

upt = pt f u ( t )



rpt = pt 1 − f u ( t ) 


with:

upt
rpt
pt
f u (t)

Urban population; [persons]
Rural population; [persons]
Total population; [persons]
Proportion of the population living in urban areas; [%]

default values:
In the model the assumption is made that a growing percentage of the population of St.
Lucia will be living in urban areas in the next 40 years. In 1990, the urban population
was estimated (from the population statistics) to be 36.1 %, and the hypothesis is made
that this proportion will increase to a value of 54.01 % in 2030.

2.2.3

Wealth
definition:
The social well-being is expressed as the employment participation rate, meaning the
proportion of people having a paid job.
mathematical formulation:

ut =

∑X

i ,t

i

pt

with:
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ut
pt
X i ,t

2.3.

Wealth or employment participation rate; [%]
Total population; [persons]
Vector of sectoral employment; [persons]

The Economic sub-system
The economy of St. Lucia is modelled by means of a highly aggregated input-output
model which is coupled to the demographic sub-model. The input-output model
describes the economy of the island as a set of linear equations. We use the input-output
model in a quasi dynamic manner by evaluating it at each iteration: at each time step and
for each economic sector new demand, generated externally or internally by the
population and the economic sectors, is translated into new job opportunities and
changed needs for imports. We have chosen to model the economic sub-system by
means of an input-output model because of its representation of the interdependencies
between economic sectors, and the way it integrates imports and final demands. Hence it
describes well the economic multiplier effects and will show how changes in one
economic sector will propagate throughout the whole economy. The input-output model
used is of a type in which the technical coefficients do not change over time (non
dynamic). This means that it is assumed that the economic mix does not change
significantly in the period for which the model is applied. This is a very weak
hypothesis, certainly for long term modelling and for economies which are highly
technical in nature and where technological innovations and substitutions are very
frequent (which has not been the case for St. Lucia in the past). In principle the model
will have to be re-calibrated (that is the technical coefficients need to be recalculated)
every time substitution has taken place. Else, the numbers generated have to be
interpreted bearing in mind the fact that the model assumes constant input and output
characteristics for each type of activity. Despite the many deficiencies of this type of
model, it is one of the most widespread techniques to describe an economy and many
national or regional planning and statistics agencies will use it (Richardson, 1978).
Hence very often data for the model will be readily available.
mathematical formulation:

∆Yi , t = ∆Domi , t + ∆Ei , t
Yi ,t = Yi ,t −1 + ∆Yi ,t

∆Si ,t = ∑ Ai , j ∆S j ,t −1 + ∆Yi ,t
j

Si ,t = Si ,t −1 + ∆Si ,t
∆M i ,t = I i × ∆Si ,t
M i ,t = M i ,t −1 + ∆M i ,t
∆X i ,t =

∆Si ,t
Bi

with:

S i ,t
Yi ,t
X i ,t
M i ,t

Vector of total sectoral outputs; [million EC$]
Vector of final demands (domestic + external demand); [million EC$]
Vector of sectoral employment; [million EC$]
Vector of sectoral imports; [million EC$]
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Domi ,t
E i ,t
Ai , j

Vector of sectoral domestic demands; [million EC$]

Ii

Vector of import coefficients; [million EC$]

Vector of sectoral external demands; [million EC$]
Matrix of technical coefficients for endogenous sectors; []

calibration information:
Since no input-output model for the base year 1990 was available in St. Lucia, we have
estimated a simplified 5-sector input output table on the basis of the following:
• Ministry of Agriculture, Lands, Fisheries and Forestry: Annual Agricultural Statistics
Digest 1992
• Government Statistics Department: National Accounts 1977 to 1992
• Government Statistics Department: Annual Statistical Digest 1991
• St. Lucia Tourist Board: Selected Tourism Statistics
• St. Lucia Tourist Board: St. Lucia Stay Over Visitors Survey – Summer 1995
A detailed description of the estimation procedure can be found in Annex B of this
report.
2.3.1

External demand
definition:
The external demand per sector is defined as an externally provided time series. The
time series per sector are to be derived from the long term economic forecasts and
calculated under conditions of no climate change. If such forecasts are not available, the
time series reflect best estimates, hypotheses or scenarios entered by the user.
mathematical formulation:

ei ,t = f e ( t )

with:

ei ,t

Vector of projected external demands ceteris paribus; [million EC$]

calibration information:
Detailed long term economic forecasts per sector were not available in St. Lucia. The
time series entered for the different economic sectors are pure hypotheses. They reflect a
transition from an agriculture and tourism based economy towards a more industry and
services based economy.
2.3.2

Domestic demand
definition:
This sub-model calculates the domestic demand as the product of the consumption per
head of goods from each economic sector and the total population. The consumption per
head varies as a function of the level of wealth, thus expressing the fact that people spend
a larger proportion of their total budget on elementary goods (food) when the level of
wealth decreases.
mathematical formulation:

(

)

∆Domi ,t = Ci × exp ni × (ut − ut =0 ) × ∆pt

with:
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Domi ,t
ut
pt
Ci
ni

Vector of sectoral domestic demands; [million EC$]
Wealth or employment participation rate; [%]
Total population; [persons]
Vector of sectoral domestic demand coefficients; [million EC$]
Vector of influences of wealth on domestic consumption; [million EC$]

calibration information:
In order to estimate the effect of wealth on the consumption behaviour of people, a
detailed survey is required. Such a survey was not available. As a result, no effect of
wealth on the consumption behaviour is assumed ( ni = 0 for all economic sectors)
2.3.3

Jobs
definition:
This MBB calculates the number of jobs in each sector as the labour input in the
economy divided by the cost per job.
mathematical formulation:

∆X i ,t =

∆Si ,t
Bi

X i ,t = X i ,t −1 + ∆X i ,t
with):

X i ,t
S i ,t
Bi

Vector of sectoral employment; [persons]
Vector of total sectoral outputs; [million EC$]
Vector of employment coefficients; [million EC$ / person]

calibration information:
See Annex B

2.4.

Land density calculation
Newly born people or immigrants require space to live. Similarly, new jobs require
suitable land for the associated production activities. Thus, new people and new jobs in
each sector are translated into residential and sectoral demands for land, using current
levels of land density. Land density is defined as the number of people who can live or
work on 1 spatial unit (cell or ha). It varies in time as a function of the pressure on the
land and the marginality of the land.

2.4.1

Socio-economic land demand
definition:
In the land density expression, land is treated as a Ricardian scarcity or a relatively
scarce resource (Barbier, 1989). For each type of land-use --economic and residential-and at each time step, land density is calculated. The suitability of the land will
influence the spatial extension of economic or residential land-uses via two mechanisms.
The first is the pressure on the land, which is an expression of the fact that with good
land getting scarce activities will try to occupy less land to produce the same amount of
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economic output. Pressure on land is defined as the amount of suitable land occupied by
a sector as a proportion of the total suitable land available for that sector. The latter is
the suitable land already taken in by the activity and land in the ‘Natural’ and ‘Forest’
state. The second mechanism concerns the marginality of the land, expressing the fact
that as good land is getting scarce, activities will have to occupy less adequate --or more
marginal-- locations and hence more land is required to obtain the same amount of
output. The marginality of the land is the average suitability of the land occupied by the
sector. The combined effect of both mechanisms is reflected in the land density
calculation.
mathematical formulation:

Wi ,0 =

X i ,0
N i ,0

 SS
 
 N

 SS

i ,t

TS i ,0 

 TS

i ,t

SS i , 0

Wi ,t = Wi ,0 

σi

i ,t

N i ,0

i ,t

SS i ,0





ζi

with:

Wi ,t

the subscript i includes the sector ‘residential’ otherwise represented as p
Vector of land densities; [persons /cell]

SSi ,t

Vector of suitabilities summed over the cells occupied by the activity; []

TSi ,t

Vector of suitabilities summed over all ,Natural’ and ‘Forest’ cells; []

N i ,t

Vector of total cells required; [cells]

X i,0
σi
ζi

Vector of sectoral employment, including the sector residential; [persons]
vector of sectoral sensitivities to land pressure; []
vector of sectoral sensitivities to land quality (marginality); []

Calibration information:
In the model, the initial values for the land density ( Wi , 0 ) are calculated from the land
use map (to calculate the total amount of land taken in by each activity) and the data
from the demographic and the economic sub-model. If the user changes the original land
use map, the population or economic data, the model will automatically adjust the initial
land densities. The parameters σ i and ζ i have been calibrated based on data obtained
from (personal communications) the Ministry of Agriculture (minimum and maximum
area of farm and estate land per person employed) and the Ministry of Tourism
(minimum and maximum hotel area per person employed).
2.4.2

Land use
definition:
The total demand for land is calculated as the total amount of jobs or residents that have
to be allocated at a given density. These demands for land are then passed onto the
Micro-level model for allocation on the basis of short range interaction mechanisms and
environmental factors reflected in the suitability maps.
mathematical formulation:
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Xi, t
Wi,t
p
= t
W p ,t

N i ,t =

N p ,t
with:

2.5.

N i ,t

Vector of sectoral total cells required; [cells]

pi ,t

Total population; [persons]

X i ,t
Wi ,t

Vector of sectoral employment; [persons]
Vector of land densities; [persons/cell]

SIMLUCIA: an integrated model
Although the sub-systems have been dealt with separately, they are strongly inter-linked
with one another via the feedback loops that are built into the model. The most essential
of these are shown in Figure 2. This scheme allows to follow through the calculations
that the model performs at each simulation time step. It also allows to reason in a
qualitative manner about direct and indirect impacts of climate change on the island. As
an example of this, one can follow through the following chain of effects: (interpret the
symbol ‘→‘ as ‘this will have an effect on’): imagine a temperature rise of 2°C and sea
level rise of 10 cm by 2025 → the external demand for tourism, namely: a drop in
number of tourists → the total demand for hotel facilities and services → construction
and maintenance of hotels, the creation of new services and the number of jobs (in the
tourism and construction sector) → jobs → wealth → mortality and migration rates (e.g.
a drop in the number of jobs in the tourist sector leads to higher unemployment rates,
which influences people’s decision to migrate out, leading to a decreasing total
population, which in turn decreases the amount of residential land required). Notice also
the loop indicating the natural loss of available land due to the rising sea level.
Due to the globally non-linear character of the model and the high degree of linkage
among the variables, the set of equations can not be solved analytically; rather their
simultaneous solution is simulated numerically on the computer as a time trajectory for
the state of the system.
In summary, in the Macro-level model the growth of the population is a result of long
term demographic trends and the economic output. Growth in the different economic
sectors is the result of changes in the demands for goods of these sectors. External
demand is subject to the effects of climatic change. The density calculation will translate
the growth coefficients of each sector in changing demands for land. The allocation of
activities to specific locations takes place in the Micro-level of the model. The next
chapter will deal with the modelling technique that performs this allocation on the basis
of local interaction mechanisms.
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3.

Micro-Level Dynamics

In St. Lucia, like in most other small islands and coastal nations, activities are strongly
concentrated in a narrow coastal zone. This results in conflicts of interest and
competition for space and causes irrecoverable stress on the unique but fragile terrestrial
and marine ecosystems of the coastal zone. Hence, it is very important to have a good
understanding of the processes that affect the coastal zone directly but also indirectly.
More than this, it is essential to know where the coastal zone will be affected, because
socio-economic pressure is never ‘average’, nor is it ‘constant’ in time or distributed
‘evenly’ over the coastal zone. Rather, socio-economic pressure is variable in time and
in space as it is the result of the interaction between mobile social and economic agents.
Thus, even if we are able to learn from our Macro-level model that a particular economic
sector, such as tourism, could be largely affected by changing climatic conditions, that
would not tell us were on the island such changes would take place, nor what conflicts it
would create with other activities. Clearly, the knowledge as to whether changes will
concentrate in one location or another, or will spread out over large parts of the coastal
zone is of great importance in estimating the real effects of the development.

3.1.

Cellular Automata models
At the descriptive level, some of this information can be captured in a Geographical
Information System. Dynamic modelling and prediction, however, requires going far
beyond the capabilities of a GIS. In our modelling framework, advantage is taken to the
extent possible of the functionality offered by GIS, such as: data management, data
transformation, data vizualisation, cartographic modelling and spatial analysis. On the
information rich GIS data-layers dynamic socio-economic and socio-environmental
models are built that threat space as consisting of a two-dimensional matrix of small
cells. On this grid we develop a Constrained Cellular Automata model representing the
land use dynamics of the island.
Cellular Automata can be thought of as very simple dynamic spatial systems in which the
state of each cell in an array depends on the previous state of the cells within a
neighbourhood of the cell, according to a set of state transition rules. Because the system
is discrete and iterative, and involves interactions only within local regions rather than
between all pairs of cells, a Cellular Automaton is very efficient computationally. It is
thus possible to work with grids containing tens of thousands of cells. The very fine
spatial resolution that can be attained is an important advantage when modelling land use
dynamics, especially for planning applications, since spatial detail represents the actual
local features that people in a city experience, and that planners must deal with.
A cellular automaton consists of (Langton, 1986):
1. an Euclidean space (two-dimensional in our application) divided up into an array of
identical cells;
2. each cell is surrounded by a neighbourhood of the same size and geometrical shape,
3. each cell is in one of n discrete possible states (land-uses in our application),
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4. transition rule(s), possibly of a hierarchical nature, describe the new state of a cell as
a function of its own state and the state of the cells in its neighbourhood,
5. time progresses uniformly, and at each discrete time step, all cells simultaneously
change state as defined in the transition rule(s).
In purely practical terms the cellular model will calculate how land use is changing from
year to year. To that end it will perform a calculation for each cell of the grid. This
calculation will be done within the neighbourhood of the cell, which consists of a
circular neighbourhood covering the 196 cells that are nearest to the cell. The
calculation will look primarily at the types of land use present in the neighbourhood and
will estimate on that basis what the best use of the cell would be given the composition
of its neighbourhood. In addition, and for the cell proper, it will take into account its
suitability to support a specific land use and its position relative to the road network, to
estimate whether the cell should be taken in one or the other land use.
Although Tobler (1979) called cellular automata ‘geographical models’, they have hardly
been used for modelling socio-economic phenomena. They have been applied more
extensively to model spatial flow and diffusion processes: surface and sub-surface water
flows, forest fires, and starfish outbreaks (Bradbury et al. 1990).
The approach has several advantages in the study of spatial phenomena. In the context of
this report we mention:
1. Cellular automata allow extreme spatial detail.
2. They tend to produce complex (Wolfram, 1986; Langton, 1986) and frequently fractal
patterns.
3. They show, at least at the functional level, apparent similarities with the overlay
analysis known in GIS (Tomlin and Berry, 1979) and their (conceptual and technical)
linkage with GIS is feasible.
4. Expanding on the previous point, the approach permits a straightforward integration
of physical and environmental qualities in economic and social modelling; in contrast,
practically all regional models currently postulate uniform background conditions.
This integration of socio-economic and environmental variables is certainly of major
importance in our modelling exercise.
5. Building a cellular automaton model and calibrating it are done in one and the same
process. They are both accomplished with the definition of the correct rules for the
transition functions.

3.2.

A Cellular Automata model for St. Lucia
For the application to St. Lucia, the Cellular Automata model is specified as follows:
1. St. Lucia and its surrounding coastal waters is represented by means of a matrix of
186 (N-S) rows by 121 (E-W) columns and 22,506 cells. A cell size of 250 m has
been chosen. This size represents well the actual plot sizes for tourism, industrial,
service and residential land use. However, a cell size of 250 m is hardly detailed
enough to represent well the relief of St. Lucia. This relief is typified by very strong
changes in elevation over very short horizontal distances. Due to the grid
representation, only one elevation reading per cell is possible; in general an average
for the whole cell. This has in particular an effect on the representation of the sharp
peaks (such as both Pitons) and the beaches, which in general cover an area smaller
than 250 by 250 m. Peaks, get an elevation which is lower and beaches an elevation
which is higher than their real elevation. Since the calculation of sea level rise is
directly related to the elevation of coastal cells, one should be careful in interpreting
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the amount of land that is really at risk. Also the representation of the (remnants of)
mangrove areas is difficult in this type of grids.
2. Each cell is in one of 15 states (y), each representing a land-use (including natural
land-cover and sea). We distinguish between the state variables for which the Macrolevel model calculates the changes:
(1) natural vegetation (mainly bush);
(2) forest (mainly secondary forest);
(3) agriculture;
(4) industry and quarries;
(5) trade and services;
(6) tourism;
(7) rural residential;
(8) urban residential;
and a number of additional land-uses for which (at this moment) the Macro-scale
model is not calculating growth coefficients:
(9) forest reserve,
(10) mangroves
(11) sea,
(12) beach,
(13) coral reef,
(14) terminals, ports, airports, etc.,
(15) infrastructure, water, electricity.
3. The geographical (physical, environmental, institutional, infrastructural, …)
characteristics of St. Lucia are represented in the relief map, the suitability maps, and
the (road network) accessibility maps.
4. The fate of a cell at each iteration depends on the state of the cell itself and the cells
in its Cellular Automata neighbourhood. The neighbourhood consists of 196 cells,
each of which falls within one of 30 discrete distance categories (see Figure 5).
5. The net number of cells Tz required by each economic or residential function z at
each time step is determined by the land density calculation in the Macro-level model.
It is imposed upon the Cellular Automaton model as a constraint.
The Cellular Automata transition rules that decide on the fate of a cell are ranked
hierarchically according to the priority with which they are applied. There are 3 prioritylevels:
Rules of priority 1 are the user interventions. They reflect decisions imposed on the
system by the user (and invoked by means of one of the editors that the user has at his
disposition). They include interventions such as imposing a land-use on a specific cell
(e.g. extension of the airport), man-made levelling-up of the land (in the relief map),
investment and infrastructure works to change the suitability or the accessibility of a cell,
etc. These rules are typically limited to the cell itself (neighbourhood of only 1 cell),
they apply only once (for one time step). A rule of priority 1 overrules all other possible
changes made by rules of priority 2 or 3.
Rules of priority 2 are rules related to the elevation of a cell above sea level. These
rules govern largely the evolution of the additional land-uses (Beach area, Mangrove
area, Natural land and Sea) in the cellular model. These rules are as follows:
A cell is or will change to ‘Sea’ (Zsea) if its elevation (h) is below sea level (h < 0). All
the other cells (elevation above sea level: h > 0) are ‘Land’ (Zland). A land cell (Zland)
with an elevation not higher than 0.5 meter (h ≤ 0.5) is or will change to ‘Mangrove’
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(Zmangrove) if it has among its 8 nearest neighbours (N8) more mangrove cells than
beach cells. Otherwise it is or will change to ‘Beach’ (Zbeach). A land cell with an
elevation above 0.5 meter (h > 0.5) is or will change to ‘Natural’ (Znatural) or to
‘Forest’ (Zforest) and will change further subject to rules of priority 3 (Equation 1). The
choice between ‘Natural’ and ‘Forest’ is determined on the basis of the suitabilities of
the cell. If the suitability for ‘Forest’ (Sforest) is higher than the suitability for ‘Natural’
(Snatural), the cell will become ‘Natural’, if not it will become ‘Forest’:

if ( h < 0) then Z sea
 


if ( 0 ≤ h < 0.5) then if  ∑ Z mangrove > ∑ Z beach  then Z mangrove else Z beach 

N8
  N8


[(

)

if ( h ≥ 0.5) then if S forest > S natural then Z forest else Z natural

]

The changes in the sea level not only alter the actual land-use of a cell, but also affect its
suitability values. In the model the suitability values for cells that rise above sea level
can be set by the user in the ‘Land loss’ dialog. The default values are given in the table
below (which is a screen dump of the Land loss-dialog).

Rules of priority 3 apply to the ‘Natural’, ‘Forest’, ‘Agriculture’, ‘Industry and
Quarries’, ‘Trade and Services’, ‘Tourism’, ‘Rural Residential’, and ‘Urban Residential’
cells. Except for ‘Natural’, and ‘Forest’ which are the ‘no-use’ states, these are the landuses reflecting the state variables of the Macro-scale model. Rules of priority 3 calculate
for each cell a transition potential for each activity. The transition potential is an
expression of the ‘strength’ with which a cell is likely to change state to the state for
which the transition potential is calculated. Transition potentials are calculated as
weighted sums:

Pz = f (S z ). f ( Az ).∑∑ (wz , y ,d × I d ,i ) + ε z
d

Pz
f(Sz)
f(Az)

(eq. 1)

i

potential for transition to state z,
function (0 ≤ f(Sz) ≤ 1) expressing the suitability of the cell for activity z,
function (0 ≤ f(Az) ≤ 1) expressing the accessibility of the cell for activity z,

f (S z ) = S z ; if

∑∑ (w

z, y, d

d

× I d ,i ) >0

i

Page 26

(eq. 2)

f (S z ) = (1 − S z ); if

∑∑ (w

z, y,d

d

× I d ,i ) <0

(eq. 3)

i

is the weighting parameter applied to cells with state y in distance zone d (0 ≤ d
≤ 30),
i
is the index of cells within a given distance zone d
Id,i = 1 if the state of cell i in distance zone d = y,
Id,i = 0 if the state of cell i in distance zone d ≠ y,
εz
is a stochastic disturbance term.

wz,y,d

Thus, cells within the neighbourhood are weighted differently depending on their state y
and also depending on their distance d from the centre cell for which the neighbourhood
is defined. Since different parameters can be specified for different distance zones, it is
possible to build in weighting functions that have distance decay properties similar to
those of traditional spatial interaction equations. To reflect the unknown factors in
location decisions, the deterministic transition potentials are subjected to a stochastic
perturbation, εz.

ε z = 1 + [ − ln( rand ) ]

a

Figure 4: A function editor is used to click-in the weighting parameters of the transition
expression (eq.1). The graph shows the influence of the proximity of ‘Terminals, Ports, Airports,
etc.’ in the possible transition of a cell to ‘Urban Residential’.

The Cellular Automata transition functions will be entered graphically by means of a
tool, mainly consisting of an X-Y graph, in which the user can draw, by mouse-clicking,
the distance decay function defining the weight coefficients used in the calculation of the
probability for transition to any type of land-use. Figure 4 shows the tool used. Negative
values express push factors or repulsion effects, and positive numbers express pull
factors or attraction effects. Transition weight coefficients are relative numbers. This is
true for weights defined within one transition function as well as across functions and
land-uses. For example in the transition pair of Figure 4, a value -9 on the ordinate at d =
2.24 has to be read as 4.11 times less important than +37 at d = 3.61. Furthermore it
represents a repulsion rather than an attraction effect. Both values represent the total
weight accorded to the whole distance ring. Hence, the weight of -9 is the total weight of
the 8 cells of ring 5 (the centre cell is distance ring 1), while the value +37 is the total
importance of distance ring 9 and spread over the 8 cells (see Figure 5). The
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neighbourhood of the cellular automaton incorporates 197 cells, including the centre cell.
All cells of the neighbourhood are in 1 of 30 distance rings between 0 and 8 cell
diameters away from the centre.
To select the Tz cells to receive the function z at each iteration, the potentials calculated
for all cells for transition to all states are ranked from highest to lowest. Starting with the
highest value from this list, the Tz cells with highest potentials for transition to each state
z are identified and the transitions are executed. Hence, a cell will change to the state for
which its potential is highest, unless it is not among the Tz highest potentials in which
case it might change to a state z’ for which its potential ranks second, and so forth. All
the cells for which potentials are not among the Tz highest for any of the z states will
remain in or return to the ‘Natural’ or ‘Forest’ state.

Figure 5: Left: all cells in the Cellular Automata neighbourhood are in 1 of 30 distance rings.
Right: Number of cells in each of the 30 distance rings.

3.3.

GIS information in SIMLUCIA
In addition to the neighbourhood calculation, the transition potentials take also into
consideration the intrinsic suitability of a cell as well as its accessibility.

3.3.1

The Suitability Calculation
The suitability f(Sz) of a cell is a measure of the capacity of that cell to support the
activity (land use) of type z. Suitability calculations are rather standard operations in
GIS. It is a composite measure, a weighted sum or product, of a series of physical,
environmental, and institutional characteristics (called factors) of each cell. Factors are
unique characteristics of a cell, such as: its topography, its quality of soil, its rainfall, its
sensitivity to erosion, its planning regulations, its legal restrictions on land use, etc.
Most advanced GIS packages have overlay analysis or cartographic modelling techniques
(see e.g. Wright, 1990) available to perform the calculations required to produce
suitability maps. In SIMLUCIA, the suitability calculations have been performed by
means of IDRISI. The data and the macros required to perform the calculation, are
available on the SIMLUCIA diskettes. For the calculation of the suitabilities the
following factor maps have been retained:
(1) RELUSE.IMG

Land use and vegetation (Atlas of St. Lucia 1/50.000)
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(2) LANDUSE.IMG

Land use in 1990 (Atlas of St. Lucia 1/50.000; Topographic
sheets of St. Lucia 1/25.000; St. Lucia Tourist Map, Ordnance
Survey 1/50.000; Map established as part of UNDP project
STL/001/86 National Physical Development Strategy,
1/25.000; Personal observations)
(3) ELEVAT.IMG
Elevation (Topographic sheets of St. Lucia 1/25.000, St.
Lucia Tourist Map, Ordnance Survey 1/50.000; Imray-lolaire
Yachting Chart of St. Lucia, 1/72.000)
(4) SLOPEC.IMG
Slopes (calculated from (3))
(5) RELZONE.IMG
Life zones (Atlas of St. Lucia, 1/50.000)
(6) RELDIS.IMG
Land Tenure (Atlas of St. Lucia, 1/50.000)
(7) RELCAP.IMG
Land Capability (Atlas of St. Lucia, 1/50.000)
(8) RSURFACE.IMG Rainfall (Atlas of St. Lucia, 1/50.000)
Variations within a factor, such as the degrees of slope, land capability classes, etc. are
referred to as factor types. A factor map is a map showing the geographical location and
distribution of factor types for a given factor. Factor maps can be combined in various
ways to generate a composite map depicting the relative capability of a cell to support a
specific land use. The technique used in SIMLUCIA is known as ‘linear combination’. It
is a common factor combination technique, which requires the analyst to define both a
rating table and a weighting table. The rating table depicts the relative suitability of the
various types within a factor. For example, slopes greater than 20% are rated 0, between
10% and 20% are rated 5, and less than 10% are rated 10. The weighting table depicts
the relative importance of the various factors in determining the overall suitability of the
cell. For example, slope might be twice as important as the depth of the bedrock. The
ratings for each type are multiplied by the weight for each factor and the result is
summed. In SIMLUCIA, the suitability values are further normalised in order to obtain
suitability values that are in the range 0-10 for all suitability maps.
The table in Annex C is a Microsoft Excel Workbook named SimLucia.XLS, containing
the 8 factors that have been retained for the calculation of the suitability maps for each
land use function of the Cellular Automata model. The rows of the table represent the
types within the factors, and the columns represent the land use functions of the model.
The values in the table, are the factor type ratings. For example, row 58, column D
contains a rating of 8 (In SIMLUCIA we work with values in the range 0 to 10) for the
capacity of a ‘Land Capability Class II’-cell to support land use ‘Agriculture’.
At the end of the table, there is a section entitled ‘Factor Weights’. This section contains
the weights accorded to each factor (and to all the types of that factor) in the final
weighting of the factors. For example the value 4 in 126, column D, means that Land
Capability is considered twice as important as ‘Land elevation’ (weight 2 in row 130,
column D). The values in the workbook SimLucia.XLS can be altered by the user. In
addition to the table, it features an Excel Macro, that will generate all the files required to
run the IDRISI macro named LucMac.IML. This IDRISI macro, will generate the
suitability required to run the model. To that end these maps have to be imported in the
model, as explained in the manual in Section 6.1.4.
While the model is running, the suitability values for all cells actually occupied by a
particular land use are monitored. Changes in the total and average suitability for each
land-use are passed back to the Macro-level and result in further changes in the land
density variables. In other words, the detailed land suitabilities and land-use patterns in
the Micro-level model have their effect in processes that are modelled at the Macro-level.
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The geography at the Micro-level thus affects the global dynamics directly and
continually.
The user can view (and edit) the different suitability maps used in SIMLUCIA.
3.3.2

The Accessibility Calculation
The accessibility calculation f(Az) of a cell is a measure of the proximity of that cell in
relation to the road network. The accessibility calculation takes into consideration the
needs of a particular activity to have good road access. It is an expression of the fact
that, for example, commercial activities have to be located in the immediate vicinity of a
road in order to be commercially viable, while quarries can be located further away from
the road (if need be a dirt track will be constructed to allow trucks to come and get the
materials mined).
The accessibility for activity (land use) z in a cell is calculated by means of the equation:

Az =

1

D
1 + 
 az 

D is the Euclidean distance from the cell to the nearest cell on the road network and az is
the coefficient expressing the importance of good road access for activity z. This
equation will return accessibility values that are in the range (0-1).
The user can view the accessibility maps for each activity in SIMLUCIA. He can also
change (Edit Menu, when the Network map is shown) the values for az to evaluate the
importance of good access for different types of land use. Finally, when selecting the
Network map, he can draw new roads or erase existing ones.
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4.

Installing SIMLUCIA

This chapter explains how to install SIMLUCIA on your computer and how to start up the
program. It also describes the main features of the user interface.

4.1.

What is included in the SIMLUCIA package ?
This package consists of this printed document and two 1.44 Mb diskettes labelled
SIMLUCIA disk 1/2 and SIMLUCIA disk 2/2. On SIMLUCIA disk 1/2 you will find a series
of compressed files and 1 executable Setup.EXE that is used to install SIMLUCIA.

4.2.

Installing SIMLUCIA
This section reviews the hardware and software requirements for running SIMLUCIA and
describes the steps to install it.

4.3.

Hard- and Software Requirements
SIMLUCIA runs on personal computers equipped with an Intel 80486 or Pentium
processor. To use the SIMLUCIA, your computer should have the following hardware
components:
•
•
•

At least 8 Mb of RAM (16Mb recommended)
A hard disk with at least 4 Mb free (for SIMLUCIA only)
A SVGA video card and screen (recommended: resolution 1024*768 pixels, 16
colours, size 17 inch or more)

To run the applications, macro’s and exercises, which we describe and provide the files
for on the demo diskettes, you should have the following software packages installed on
your computer:
•
•
•

4.4.

Microsoft Windows 95 (or Windows 3.1x with Win32 version 1.3 extension)
Microsoft Excel (version 6.0) (optional)
IDRISI for Windows (version 2.0 or later) (optional)

Installation procedure for Windows 95
The following is a description of the step by step installation of SIMLUCIA. The
installation/un-installation of SIMLUCIA follows the standard for Windows 95. If your
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operating system is Windows 3.x then move immediately on to Section 4.5 Installation
procedure for Windows 3.x.
If you have a previous version of SIMLUCIA software installed on your machine, it is
better to un-install it first. If you want to keep it though, make sure to put SIMLUCIA in a
separate distinct directory. During the installation you may encounter a message asking
you whether to keep certain files or replacing them. It is preferred to replace them for the
use of SIMLUCIA. Keeping the old ones may cause malfunctioning of the software.
1 Start Microsoft Windows 95.
2 Insert the disk labelled "SIMLUCIA disk 1/2" into the drive.
3 Click the Start button in the Windows 95 Task bar. Move the mouse pointer to the
Settings command and move on to select the Control Panel option. As a result the
Control Panel Dialog box will open. Select from the list the Add/Remove
Programs by double clicking it. Next click the Install button in the Install/Uninstall
view of the Add/Remove Programs Dialog box.
4 Next, the Windows 95 installation program will be started and will request you to
click the Next button until (1) the program has selected your disk drive as the
installation medium, and (2) until it will have found on the diskette the Setup.EXE
program for SIMLUCIA. Then, the command line "a:\setup.EXE" will appear in the
edit field of the install window. Hit Finish to have the program continue the
installation.
5 Continue clicking “Next” until the “Read Me” screen appears. Make sure to read this
page. After clicking “Next” again, a second dialog box appears asking you where to
install SIMLUCIA. You can accept the default path which is "c:\SIMLUCIA" or
replace it in the edit box by one of your choice. You may use the “Browse” button to
select this path as well.
6 To go on, press the "Next" button. Otherwise to cancel the installation process, press
the "Cancel" button. SIMLUCIA will ask whether you use Windows 95 or Windows
3.x. Select Simlucia for Windows 95. If your PC is equipped with Windows 3.x,
then follow the instructions in Section 4.5.
7 Next the installation program suggests to add SIMLUCIA to the new Program Group
SIMLUCIA. You are free to create another Group or to choose an existing one from
the list shown.
8 From that moment the installation application is decompressing the necessary files
and puts them in the directory structure of SIMLUCIA. At a certain point in time you
will be asked to insert disk #2 in the drive. Insert at that moment the disk labelled
“SIMLUCIA disk 2/2”.
9 If everything went OK, a last dialog box will inform you about the fact that the
installation is finished. Once the installation on the hard disk is completed, the
program creates a group named “SIMLUCIA” under the Start button and Programs
command. It contains an item labelled “SIMLUCIA”. When you double click this
item, SIMLUCIA will be started and the “About” window will appear. Click “OK” to
enter the Application Window.

4.5

Installation procedure for Windows 3.x
If you have a previous version of SIMLUCIA software installed on your machine, it is
better to un-install it first. If you want to keep it though, make sure to put SIMLUCIA in a
separate distinct directory. During the installation you may encounter a message asking
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you whether to keep certain files or replacing them. It is preferred to replace them for the
use of SIMLUCIA. Keeping the old ones may cause malfunctioning of the software.
4.5.1

Running SIMLUCIA under Microsoft Windows 3.1x
SIMLUCIA has been developed to run under Microsoft Windows 95. However, it is
possible to run it under Windows 3.1x as well. In order to do so, you need to install
Microsoft Win32s version 1.3.
Microsoft Win32s is an extension of the operating system that allows Win32
applications for Microsoft Windows NT and Microsoft Windows 95 to run on
Microsoft Windows version 3.1x and Microsoft Windows for Workgroups.
You need to have Microsoft Win32s version 1.3 installed on your system before you
can install SIMLUCIA.
If you don’t have Microsoft Win32s version 1.3 installed on your computer ask your
system administrator to help you installing it.

4.5.2

How to get Microsoft Win32s version 1.3
Microsoft Win32s is available from the Microsoft Software Library (MSL) as
PW1118.EXE. You can download it via anonymous FTP from Microsoft:
1. C:\ftp ftp.microsoft.com
2. Change to the Softlib/Mslfiles folder
3. Get PW1118.EXE
You can also use the Microsoft Network or the Microsoft Download Service (MSDL).
PW1118.EXE is a self-extracting file containing the Win32s files in a compressed form.
To install Win32s from PW1118.EXE:
1. Create a temporary install directory on your computer and copy PW1118.EXE to this
directory.
2. Execute PW1118 (by double-clicking PW1118.EXE in the file manager). This
decompresses the Win32s files into an installation layout (setup program) in your
temporary install directory.
3. Run the Setup program (by double-clicking Setup.EXE). The setup program installs
(or upgrades) Win32s and restarts the Windows operating system to update the
system files.
4. Delete the temporary install directory and its contents

4.5.3

Installing SIMLUCIA under Microsoft Windows 3.1x
It never harms to make a copy of your installation diskettes before starting the
installation procedure. If you have a previous version of SIMLUCIA software installed on
your machine, it is better to un-install it.
The following is a description of the step by step installation of SIMLUCIA.
1
2
3
4

Start Microsoft Windows.
Insert the disk labelled "SIMLUCIA disk 1/2" into the drive.
Select File from the Program Manager menu bar and choose the Run... command.
A dialog box appears. Enter "a:\setup.EXE" in the edit field. Next, click the OK
button or press ENTER.
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5 The screen turns blue and a second dialog box appears asking you where to install
SIMLUCIA. You can accept the default path which is "C:\SIMLUCIA" or replace it in
the edit box by one of your choice.
6 To go on, press the "Next" button. Otherwise to cancel the installation process, press
the "Cancel" button. When given a choice between installing under Windows 95 or
Windows 3.1 choose the latter.
7 From that moment the installation application is decompressing the necessary files.
At a certain point in time you will be asked to insert disk #2 in the drive. Insert at that
moment the disk labelled “SIMLUCIA disk 2/2”.
8 If everything went OK, a last dialog box will inform you about the fact that the
installation is finished. Once the installation on the hard disk is completed, the
program creates a group named “SIMLUCIA” in the Program Manager. It contains an
item labelled “SIMLUCIA”. When you double click this item, SIMLUCIA will be
started.

4.6.

Starting SIMLUCIA
To invoke the complete environment
1 Start Microsoft Windows.
2 Under the Windows 95 Start button and the Programs group, you will find a group
called SIMLUCIA. Double-click on the SIMLUCIA icon in the SIMLUCIA group.
3 SIMLUCIA will be started and you will see the SIMLUCIA Application window on
your screen.

4.7.

Screen Layout
When you start SIMLUCIA, you will enter immediately in the Application Window of the
simulation environment. This is the window in which you will run your models. Before
a simulation file is opened, the screen is empty except for its top part. Below we will
describe the different components of this screen.
Control Menu Box

Menu Bar

Caption Bar

Tool bar

Application Window
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Status bar

Application Window

4.7.1

The Control Menu Box
The Control Menu box contains the Application Window Control Menu, which controls
how windows are arranged on the desktop. The list below summarises the Control Menu
Commands.
Use this command
Restore
Move
Size
Minimize
Maximize
Close

4.7.2

To
Restore the window to its previous size
Move the window using the arrow keys.
Change the size of the window. You can use the mouse or the arrow keys
to change the size.
Shrink the window to an icon
Enlarge the window to the full size of the screen
Close the application window

The Caption Bar
The Caption Bar, also Title Bar, of the Application Window displays “SIMLUCIA”.
To the left of the Caption Bar three buttons are positioned that enable you to re-size the
Application window.
• The Minimize button allows you to shrink the window to an icon (same as Minimize
in the Control Menu Box);
• The Maximize button allows you to enlarge the application window to the full size of
the screen (same as Maximize in the Control Menu Box);
• The Close button allows you to close the application window, and thus quit the
application (same as Close in the Control Menu Box)

4.7.3

The Menu Bar
The Menu Bar of the Application Window contains SIMLUCIA’s main Menu. The
commands are logically organised in the menu so that you will quickly become
comfortable with the various functions of the program. The menus are summarised in the
table below; subsequent chapters elaborate on the description. Chapter 6 gives an
overview of all menu commands.
Use this menu
File
Edit
View
Maps
Rules
Simulation
Options
Window
Help

To
Manage your simulation files. The printing facilities are also located in this
menu, and if you want to exit the program, you can do it from here.
Edit the maps that are part of the Micro-scale model. All commands for
editing are located here. Depending on the type of map that is active, the
appropriate edit features are listed and accessible.
Enables to change the way a map is displayed. Commands to zoom in and out
as well as commands to display information on the foreground or background
of the maps are part of this menu.
Open a new window with one of the maps of the modelled region.
Define the model at the Micro-level by means of the Cellular Automata
transition rules.
To control the simulation. The commands in this menu are the same as the
ones represented by means of the buttons in the Tool bar.
To customise the workspace. Commands permit among others to display or
remove the Status bar and/or Tool bar, and to (DDE) link the simulation
package to Excel.
Manage your windows on the screen
Invoke the on-line Help facilities.
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4.7.4

The Tool bar
The Tool bar, also known as Speed Bar, gives a faster access to some of the more
frequently used commands which are also accessible via the menu.

Use this Button

To
Open a simulation file from the disk.
Save a simulation file to disk.
Change the pointer to a pen. The pen is used to pick a value from the legend
and enter it in a cell on the map.
Change the pointer to a bucket. The bucket is used to pick a value from the
legend and enter it in larger, contiguous areas on the map.
Change the pointer to a ruler. The ruler is used to enter detailed information
in a cell. When a cell is clicked, a dialog will open to enter the exact value.
Zoom-in. Increase the size of the map on the display.
Zoom-out. Decrease the size of the map on the display.
Advance the simulation with one simulation step.
Advance the simulation till the next pause is reached (as set with the Pauses
... command).
Stop the simulation.
Reset the simulation. State variables of the model and maps take their initial
values, parameters keep their actual values.
To print the Micro-scale dynamics window.
Access the context sensitive help cursor. The next click action on a
command will invoke the context sensitive help on this command.

The Tool bar also displays the simulation clock. Each time step, the clock is updated.
The figure indicates the years simulated in the range 0 to 40.
The Tool bar command in the View Menu allows to display or hide the Tool bar in the
SIMLUCIA Application Window.
4.7.5

The Status bar
The Status bar is displayed at the bottom of the Application Window. This zone
provides information to the user on his actions while he is working with the application.
The left area of the status bar describes actions of menu items as you use the mouse or
arrow keys to navigate through menus. This area similarly shows messages describing
the actions of toolbar buttons when pressed. The right area of the status bar indicates
which of the following keys are latched down:
Indication
CAP
NUM
SCRL

Description
The Caps Lock key is latched down.
The Num Lock key is latched down.
The Scroll Lock key is latched down.
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The Status bar command from the View Menu allows to display or hide the Status bar in
the SIMLUCIA Application Window.

4.8.

Getting Help
SIMLUCIA comes with a very concise on-line Help facility. Its structure and operation is
in accordance with the Microsoft Help standards. Hence, using Help should pose no
problems for those familiar with Windows.
To get Help, press “F1” or the key sequence ALT-H
The Help menu has 3 items:
1 “Index” gives an access to the index of the help guide.
2 ”Using Help”, gives the general instructions on how to use the Windows Help
System.
3 “About SIMLUCIA ...", gives information about the copy of the SIMLUCIA that you
are using.

4.9.

Exiting SIMLUCIA
Closing SIMLUCIA is simply done by selecting the Exit command from the File menu. If
you have simulation files open when you select Exit, the application will ask whether
you want to save simulation results. If you confirm to be interested in saving results you
will get the Save Dialog box. More information on saving simulation results is given in
the next chapter.

4.10.

If you experience problems
If you experience problems in installing or running SIMLUCIA, contact:
Research Institute for Knowledge Systems bv.
To the attention of Inge Uljee or Guy Engelen
P.O. Box 463
6200 AL Maastricht
The Netherlands
Tel: +31 43 388.33.22
Fax: +31 43 325.31.55
E-mail: info@riks.nl
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5.

Running SIMLUCIA Simulations

This chapter describes how to run simulations with SIMLUCIA. In the previous chapter
we explained how to install and run SIMLUCIA. We assume from now on that you have
read this information, that you have knowledge of the different technical terms
introduced, and that you have successfully installed SIMLUCIA on your computer.

5.1.

Running a simulation
Click the Start button in the Windows 95 Task bar and point the cursor to the Programs
group. Move through the cascading menu into the SIMLUCIA group and open SIMLUCIA
by clicking the SIMLUCIA icon. If the software has been installed successfully, the
Application Window will open. Immediately the About Information Window will open.
Push the O.K. button (or the SIMLUCIA icon) after having read the information and
warnings in the About Window. Immediately the Open dialog box will open. If not,
push the Open Simulation file button.
Look in the Open dialog box for files with a .SIM extension.
By means of the standard
Windows 95 manipulations you can navigate
through the directories on
your hard disk, or on
another computer in the
network, in search of the
simulation file of your
choice. Once the name of
the file appears in the
Open Dialog Box, select it
and press the Open button
or double click the file
icon.

In fact the .SIM file contains references to all the files that are required to run a model.
Later in this chapter we will give more details about the contents and composition of the
.SIM files.
Once all files have been loaded, two windows will appear in the Application Window:
one titled Micro-scale dynamics and the other Macro-scale dynamics.
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5.1.1

The Micro-scale dynamics Window
The Micro-scale dynamics Windows is split into 3 viewing areas, called Panes. Panes
are separated from one another by means of Splitter Bars. You can displace the Splitter
Bars to change the size of the Panes. To this end, position the cursor over the Splitter
Bar. The cursor changes to the Split Pointer (see Annex D for the pointer shapes). With
the left mouse button clicked down, the Splitter Bar can be moved and the size of the
Panes are adjusted accordingly.

Legend Pane

Map Pane

Splitter Bar

Focus Pane

The Pane on the left of the Micro-scale dynamics Window --called the Map pane-contains a map representation of the modelled region. More in particular the actual land
use of the region is mapped. The legend of the map is displayed in the upper left pane -called Legend pane--. The lower left Pane --called the Focus pane-- shows the mapped
region in small. In the upper part of this small map you will see a wire-frame (an
inverted rectangle). This shows the area (called focus) that is displayed in the Map pane.
If the mouse is placed inside this wire-frame, the frame can be moved while holding the
left mouse button clicked down. While the wire-frame is moved, you will notice that the
focus of the map in the Map pane is changing accordingly. The focus of the map can
also be changed by means of the scroll-bars of the Map pane. The Legend pane too is
equipped with a vertical scroll bar.
When a simulation is running, the Micro-scale dynamics Window will be updated and
the resulting land use will be displayed in the Map pane.
The commands of the View Menu permit to change the manner in which Micro-scale
results of the model are displayed in the Map pane. Display options include among
other: Zoom in, Zoom out, and 3-D representation. For a complete overview, consult the
View Menu in Section 6.3 of this User guide.
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Most features of the Micro-scale models are accessible via the menu structure of the
system. Details on the different menu options is given in Chapter 6 of this guide. Here
we will focus on a number of elements that are essential to understand the functioning of
the Micro-scale model and to change its parameters.
At this moment, SIMLUCIA‘s Micro-level model (see for details Chapter 3) calculates
and displays the changing land use. The legend of the map explains the meaning of the
different colours. A distinction is made in the model (and the legend) between the
dynamic elements of the land use and the non-dynamic elements. Dynamic elements -also called Land-use Functions-- are represented in the legend of the map with their
name underlined. The static elements --also called Land-use Features-- are represented
with their text not underlined.
Land Use Functions:
Forest
Natural vegetation
Rural residential
Trade and services

Agriculture
Industry and quarries

Urban Residential
Tourism

Land Use Features:
Sea
Forest Reserve
Coral Reef
Terminals etc.

Mangrove
Infrastructure etc.

Beach

Land use features will not change as the result of Micro-scale dynamics. That is to say
they will not change location: they will not expand or will not disappear due to the
expansion of other activities. Yet, they influence the dynamics of the Land use
functions, and will interfere in the allocation process of the land use functions. For
example the Land use function ‘Tourism’ will be influenced by the presence (or absence)
of the land use feature ‘Beach’.
Rules.
The dynamic land-use calculation is based on a number of elements which can be
changed (in principle at the least) by the user of the model. First and most important are
the Cellular Automata transition rules. These represent the dynamic element of the
Micro-model. For each cell in the cellular space they will calculate how its land use will
change throughout the simulation period. The transition rules are accessible via the
Rules menu. The rules are written as distance functions, expressing the manner in which
land uses influence one another by attracting or repelling one another in their vicinity.
These rules are defined for each possible combination of land uses. The model is very
sensitive to the values entered for most rules. Hence, changing rules can have drastic
effects on the Micro-scale dynamics. We advice not to change the transition rules unless
you have gained a lot of experience with running the model. An overview of the
complete set of rules can be seen when selecting Overview from the Rules menu.
Next to the transition rules, the intrinsic characteristics of the cell itself will influence its
potential for change to another land-use. These are represented in the model by means of
maps, namely the Elevation map, the Suitability map and the Network map. All the maps
are accessible via the Maps menu.
Elevation.
The elevation map is displaying the relief of the modelled region. It is important for the
model to the extent that land below sea level is not suitable for socio-economic use and
that this land can not be allocated to one or the other land use activity. Indirectly, the
elevation will influence the suitability of a number of activities. Select Elevation from
the Maps menu to have it displayed in a new window on the screen. The View Menu
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allows to change the manner in which the map is displayed. The possibility exist to
Zoom in, to Zoom out or to change the elevation categories with the Legend Dialog box.
Suitability.
For each land-use function a suitability map is present in the model. It shows how
suitable each cell in the region is to support the particular land use. Suitability
calculations are rather standard GIS operations. Suitabilities are composite measures that
involve the manipulation of so called Factor Maps. In SIMLUCIA a linear combination
of factors has been applied: the importance of a factor type (for a specific land use) is
first rated and next, the factors are weighted and summed. In Annex C an overview of
the factor type ratings and factor weights is given. The calculations required to produce
the suitability maps have been carried out by means of IDRISI for Windows Version 2.0
(Eastman, 1997), and the resulting maps have been imported in SIMLUCIA.
The suitability map of each land use function can be selected from the Maps menu and
the way the map is displayed can be altered by means of the View and Edit menu.
Network.
For each land-use function an accessibility map is present in the model. It shows how
accessible each cell is in relation to a network. The network can be --in principle at
least-- any network. In this version of the model, the network included is the road
network. For some activities, such as Trade and services, the direct access to the road
system is more important than for other, such as Agriculture. The maps are the result of
an accessibility calculation of the parameters which are accessible via the Edit Menu.
The user can freely open and close maps (except for the land use map in the Micro-scale
window). We warn the user that opened windows are updated while the simulation is
running and that this does take-up processing time, hence that the program will be slowed
down.
More details on the use of Cellular Automata for modelling geographical phenomena at
the Micro-scale can be found in Chapter 3 and in the publications in the reference list.
5.1.2

The Macro-scale dynamics Window
The Macro-scale dynamics Window is the
graphical interface to the Macro-scale
model.
It shows an overview of the
structure of the system modelled at the most
synthetic level. It allows access to all the
details of the model at this level, but even
so at lower levels. You should learn to use
the graphical representation as a graphical
explorer of the model.
In this prototype, the model structure, nor
its graphical representation can be changed
by the user.
SIMLUCIA has been developed by means of
the simulation package GEONAMICA (see
Annex A for details). The model consists of
so-called Model Building Blocks (MBB’s)
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--the rectangles in the system diagram-- connected to one another by means of MBB
Connectors --the arrows connecting the rectangles--. A MBB contains the code required
to calculate and execute mathematical operations varying from a single operation (such
as the summation of two numbers) to a list of operations (set of mathematical equations).
In order to improve the readability of the system diagram, it is possible to group parts of
the model into a Super MBB and represent it in the diagram as a single block.
Model Building Blocks (MBB’s).
The system diagram allows the user to understand the structure of the model and to
access parts of it. Model building blocks are represented by means of a rectangle with
the name of the MBB in it.
Active Model Building Blocks appear in black on the display. When the user moves the
mouse pointer on top of such a MBB, its colour will invert. If the user clicks the mouse,
the response will depend on the type of MBB. If the MBB clicked is not a SuperMBB,
then a dialog box will open. This dialog box has the function of both receiving the data
entered by the user and of communicating model results to the user. If the MBB is a
SuperMBB, then a more detailed diagram is shown in which each of the MBB’s will act
as explained.
Connectors and Connections.
Variables and parameters can be passed from one MBB to the other via
Connections, or Pipes. MBB’s will dispense variables or parameters with
In-Connector
Out-Connector the rest of the model via Out-connectors, and will take-in information
from other MBB’s via In-connectors.

Connection

The actual exchange between MBB’s is possible when a Connection (or
Pipe) is drawn between an Out-connector of the issuing block and the Inconnector of the receiving block. For each variable or parameter that is
being exchanged, one connection is drawn (except if one of the MBB’s is
a SuperMBB) in the diagram.

Dialog boxes.
Each MBB has a dialog box attached to it. This dialog box is the vehicle that permits the
interactive exchange of information between the user and the Model Building Block.
The MBB will communicate the results (output) of its numerical operations to the user
and it will accept the data entered (input) by the user that are required for the execution
of the MBB. The latter are internal to the MBB.
Model results and model inputs are presented in Edit Fields. The difference between
input and output fields is indicated by the colour of the text in the edit field: green for
state variables (to be entered as initial values and for the remainder output of the MBB);
purple and blue for intermediate variables; black for variables or parameters copied from
other MBB’s (output of the MBB); and finally red for internal parameters of the MBB
(input for the MBB).
Colour of text in the
Edit Fields of
MBB-Dialog Boxes
RED
PURPLE

Description
Input. Parameter value (can be changed during the entire
simulation) or State variable at the initial state.
Input. Variable value. If the edit field is clicked, a dialog will
pop-up requesting input necessary for the calculation of the
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variable
Input / Output. State variable which can be changed at the start
of the simulation, and which display output for the remainder.
Output. Variable value. (read-only)
Output. Values copied from other MBB’s. (read-only)

GREEN
BLUE
BLACK

A simple way of finding out whether a field will accept input or not is by simply moving
the mouse over it. If the field can be edited, the mouse pointer will change shape in
function of the type of data that is to be entered. If the mouse is clicked, the appropriate
editor is opened. In Annex D, the meaning of the different pointers is explained.
One of four editors will open:
A single value numerical editor.
This editor allows the user to enter a single numerical value. More
precisely it will display a default setting --the result of the
calibration of the model-- with the request to change it with a value
within the range specified:
Minimum ≤ value entered ≤ Maximum
If values outside this range are entered, the user is warned.

A table (of values) editor
This editor allows the user to enter a series of numerical values. More precisely it will
request the user to change default values. The values entered will all have to be inside a
range specified:
Minimum ≤ all values entered ≤ Maximum
If values outside this range are entered, the user is warned.

A graph editor.
This editor is used extensively
in SIMLUCIA --in both the
Micro-scale and Macro-scale
model-- to change twodimensional relations: time
series, distance decay functions,
etc. It has two main parts: to
the
left
a
graphical
representation of the twodimensional relation, and to the
right a list box with the coordinate pairs defining the
relation. The relation can be
edited in each of the two parts.
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1. The easiest way to enter data is via direct manipulation of the graph. Move the cursor
to the abscissa position for which you want to enter a new (ordinate) value. The
pointer will change to a pen symbol indicating that it is positioned correctly on top of
a vertical grid line for which it will accept an ordinate value. Move the pointer to the
vertical position equal to the ordinate value which you want to enter. Then click the
left mouse button to enter the new ordinate of the point on the graph.
2 The second manner of editing is handy if you have to enter exact numbers rather than
trends or approximate numbers. It consists in clicking in the list box the co-ordinate
pair that you want to change. Then a dialog box will open in which you can enter the
new ordinate value. The changes made in one part of the graph editor are
immediately visible in the other part. The number of values to be entered as well as
the range is displayed.
A Dialog editor.
In order to enter values for specific variables (printed in purple) a dialog window is
opened. In this dialog the user is to enter a number of data that are required to calculate
the value of the variable. In SIMLUCIA this type of editor is used to define variables that
are required to calculate the number of jobs in each economic sector.

5.2.

Starting the simulation.
Once the Micro-scale dynamics and the Macro-scale dynamics windows have been
opened, the program has read-in the default values for all the parameters as well as the
initial values for all the state variables of the model. The program is ready to run a
simulation.
Verify this by pushing the Step button from the Tool bar. SIMLUCIA will now go
through a number of essential phases (such as the initialisation and testing of its
inputs) which are of no direct interest to the user before it will make one simulation
step. This will take a while. You will notice that the action is finished when the
simulation time changes from 0 to 1 and the land-use map in the Micro-scale dynamics
window is being updated.
Undo the simulation step by pushing the Reset button from the Tool bar. This action
will reset all the state variables of the model to their initial value, but will not do so
for the values of the parameters. These are not influenced by Reset and remain
unchanged. Since we have not changed parameter values the latter is of no
importance now, but it will be an important issue once you will be changing parameter
settings while running the models.
The Micro-scale dynamics and Macro-scale dynamics Windows can not be closed by the
user (the Close-Window-icon in the Title Bar of both windows is greyed out). The user
can only minimize or maximize their size by clicking the respective icons in the Title
Bar. The results of the Micro-scale models is always shown by means of the map in the
Micro-scale dynamics Window. You can personalize the Micro-scale map by means of
the command in the View and Options menu. It is possible to add overlay information to
it, such as the road system and the boundaries of the administrative regions. If the region
boundaries are drawn, it is possible to pick-up information per region from the map by
clicking the left mouse button in the region of your choice. An Information Window will
show an overview of the land use within the region. While the simulation is running, this
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overview is updated dynamically, thus permitting to get an impression of the changes
affecting the region.
The output of the Macro-scale models is not visible unless the user has opened the parts
of the model that he wants to see. As an example we will see what the model has to offer
in the Wealth MBB. Move the mouse to the MBB named Wealth. As soon as the mouse
is inside the borders of the MBB, the colour of the MBB will invert. Now click the left
mouse button. The following Dialog Box will open.
Now have the simulation make one simulation step
again while watching the values displayed in the
box. Notice that the value of the variable named
“Population“ is updated whenever the next
simulation step is taken. Finally, the Micro-scale
dynamics Window is updated. This demonstrates
the fact that models developed with SIMLUCIA have
coupled micro- and macro-components running
simultaneously. For variables preceded by a white
check-box, such as 'Total jobs' in the Wealth dialog,
the model allows to make a time-graph. All you
need to do is to click in the check box and the graph
will open. As long as it is open, it will be updated at
each simulation time step. To close it, you should
click the Close-Window-icon in the title bar of the
Graph window.

5.3.

Viewing model output
The user of SIMLUCIA has a lot of freedom in selecting and organising the in- and output
windows. There are tens of windows containing information related to the model. These
windows are all accessible in the manner explained: Macro-scale dynamics; Micro-scale
dynamics; Dialog boxes; Graphs, and Maps. A window, map or dialog will be opened by
the user and will stay open until it is minimized or closed by the user. While the
simulation is running all the windows that are opened are updated. This has the great
advantage of displaying information from linked MBB’s simultaneously and allow the
user to see how changes occur in different parts of the model.
However, the user should learn to manage output windows carefully and to close as much
as possible the windows he is not directly interested in. If not, his screen will be
overloaded with ‘left-over’ information which he is not really using, but also, every
window opened is updated by SIMLUCIA and the act of updating takes execution time
and memory space. Hence the program might slow down considerably. Certainly when
maps are displayed, it is imperative to close as much as possible the maps that are not of
immediate interest to the user.
Moving the mouse with the left mouse-button clicked-down in the Title Bar of a window,
will permit to move it around. It is good practice to organise the screen in such a way
that the dialogs are all grouped on one side of the screen and the map(s) on the other side.
This will permit to see simultaneously macro- and microscopic results of the simulations.
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5.4.

Saving simulation results
Working with Decision Support Systems is not in the least a learning process: the
decision maker is exploring different combinations of policy alternatives to learn
interactively which interventions are likely to satisfy his policy criteria. These
explorative exercises require a possibility to store simulation results in an efficient
manner.
The
Save
simulation
command
from
SIMLUCIA’s File menu
allows the user to store
simulation results in more
or
less
sophisticated
manners.
More in
particular it allows the
user to manage efficiently
the different kind of files
that constitute a single
simulation.
Indeed, a
simulation requires not
just one, but 10 to 20 data
files, hence, saving a large
number of simulation runs
might require a large
storage space on your hard
disk(s).
When the user selects Save Simulation from the File menu, the Save Dialog box will
open, requesting the user to enter the name of the file. If the name of the current
simulation file is entered, then it will be overwritten, and the original values will be lost.
Overwriting files can be avoided by simply choosing a file name different from the
current one. Once the name of the file is entered and the Save button has been pressed,
the system will display the Simulation file ... .SIM Dialog box. If you are a relatively
new user of SIMLUCIA, simply press the OK button to complete the action of saving the
simulation and skip the remainder of this section. If however, you are more experienced
with the system this Dialog box will help you to change the composition of your
simulation file before saving it.
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The dialog box shows an
overview of all the files
types
--and
their
respective names-- that
are used by the simulation. In the box, the files
are preceded by a check
box. Files preceded by a
crossed check box will be
saved with the name
mentioned to their right.
The program keeps track
of the actions that the user
has performed during a
session and knows what
files are affected by it.

These files are shown with their check-box crossed, and that is why the program suggests
to save them. If however you do not want a new copy --for example because the
corrections you made are not important-- then you simple cross out the check box.
Although this procedure might seem cumbersome at first, it will become a great help to
you once you are more familiar with the system. SIMLUCIA saves its output in exactly
the same format as its inputs. Hence, you can always use saved simulations as the input
for a new run. Keep in mind however that the simulation clock will be set back to 0
when you continue a simulation in this way.
Save simulation will only save final results of the model (current values of state variables
and parameters). It will not store intermediate results. To save these, you should make
use of the Log ... and the Link to Excel commands from the Options menu.
Log ... will save Micro-scale simulation results. More in particular it will store maps on
a .LOG file. When the Log ... command is selected, the user will have to enter the
interval for which he wants to store maps.
The Link to Excel command permits to send simulation data to a Microsoft Excel
Workbook. More in particular the values of a number of the most important state
variables will be send to Excel. It is possible to save this Workbook (using the Excel
commands) and thus store them for further analysis.

5.5.

Printing simulation results
Printing simulation results can be done in different manners. SIMLUCIA supports very
directly the printing of maps. From the File menu, you will use the commands Page
Setup, Print preview and Print for that matter. Select first Page Setup to decide on the
number of cells which you want to print out per unit of measurement (for example 4 cells
per cm for a map of St. Lucia at a scale of 1/100.000), then select Print Preview to get an
idea on how the printed maps will look like, and finally push the Print button in the Print
Preview window or from the Tool bar to print the maps.
Printing results from the Macro-level model can be done by selecting Link to Excel from
the Options menu and use the Excel print functions to get the results on paper. If you
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want a printout from a particular MBB, then click it to open its Dialog box. Once the
Dialog box is open, key-in Alt + Prt Sc. This will put the Dialog on the Windows
Clipboard. Now open your Paintbrush, Paint or Word Processing package and select
Paste from its Edit menu. Once the Dialog window has been pasted, Print the dialog by
using the print facilities of the receiving package. This procedure works not only for
dialogs, but for all SIMLUCIA’s windows. It is handy to print among other the 3 D
representation of the study area.
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6.

The SIMLUCIA Menu System

This Chapter explains the different commands that are available in SIMLUCIA’s Menu
System. The Menus will be treated as they appear in the Menu Bar from left to right.

6.1.

The File Menu

Use the File menu to create a new simulation file or open an existing
one, save and print files, and to exit SIMLUCIA.
SIMLUCIA saves simulation files with a .SIM extension attached to
the filename.

6.1.1

New simulation Command
Use the New simulation command to create a new simulation file.
This option is not available in SIMLUCIA for the model has been designed by RIKS for
the specific use on St. Lucia.

6.1.2

Open simulation Command
Use the Open command to open a simulation file stored on a disk. You can open only
one simulation file at the time. Use the Windows menu or the mouse to switch among
the different windows opened by the simulation.
When you choose Open simulation, the Open Dialog box appears. If the name of the file
of your choice is not visible in the list box, use the scroll bar to move through the list of
filenames in the directory or disk you are working in. If the file you want to open is not
in the current directory or on the current disk, use the scroll list or browse symbols in the
section named ‘Look in:’ to change directories, drives or network site.
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Double-click the name of the file you want to open. You can also type the name and path
of the file in the Filename box. Choose open after you have typed the name of the file.
6.1.3

Save simulation Command
Use the Save simulation command to save a simulation to a disk. When you save a
simulation, SIMLUCIA displays a Save Dialog box. This box shows an overview of the
different files that constitute one simulation. The file names that are preceded by a
crossed check box, have been changed by the user during the session and will be newly
saved. If the user wants to save them under a different name, he can click in the name
and enter the new name. Be careful not to change the extension of the files.

6.1.4

Import file... Command
Use the Import file command to import a file from disk into the simulation. Importing
and exporting files is possible for all maps that can be edited in the system (Land Use,
Suitability, Network, and Regions map). The type of map has to be selected from the
menu and has to be in the active window before the Import file... command will be
active. When active, Import file... will open a Open Dialog box displaying all the files in
the working directory with the correct extension. If the user changes the type of file to
import in the appropriate scroll list, he will be able to import IDRISI files with .IMG
extension.

6.1.5

Export file... Command
Use the Export file... command to export a file from the simulation to disk. Exporting
and importing files is possible for all maps that can be edited in the system (Land Use,
Suitability, Network, and Regions map). The type of map has to be selected from the
menu and has to be in the active window before the Export file... command will be
active. When active, Export file... will open a Save Dialog box displaying all the files in
the working directory with the correct extension. If the user changes the type of file to
export in the appropriate scroll list, he will be able to export files with the .IMG
extension to IDRISI .

6.1.6

Page Setup Command
Use the Page Setup command to decide on the size and scale at which you want
SIMLUCIA to print the simulation results of the Micro-level model.

6.1.7

Print Command
Use the Print command to print the maps generated by the Micro-level model.

6.1.8

Print Preview Command
Use the Print Preview command to get a preview on the screen of the printed document.

6.1.9

Print Setup Command
Use the Print Setup command to arrange the setup of your Printer, so that simulation
results will be correctly printed by SIMLUCIA.
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6.1.10 List of Recent File (1, 2, 3, 4)
SIMLUCIA keeps track of the 4 most recent files opened by the program. It will display
those in the File menu. If you select one of the 4 files, it will be opened.
6.1.11 Exit Command
Use the Exit command to quit SIMLUCIA and return to Windows.
If you have made changes to simulation files since the last time that you saved the
simulation, a dialog box appears asking whether you want to save the simulation file
before exiting SIMLUCIA.
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6.2.

Edit Menu
Use the commands on the Edit menu to edit the maps of the Micro-scale models.
The first three commands on the Edit menu are standard, but for each type of map
one or more commands will be added to permit specific edit operations. These will
be explained in more detail in the Map menu.
Be careful, SIMLUCIA in not equipped with the an Undo command. Hence all
corrections made are definite !

6.2.1

Pen Command
Use the Pen command to pick a value from the legend of the map (by clicking the radio
button next to a reading) and enter it in the map by clicking the cell of your choice.
This command will change the pointer in a pen. It is identical to selecting the Pen icon
from the Tool bar.

6.2.2

Fill Command
Use the Fill command to pick a value from the legend of the map (by clicking the radio
button next to a reading) and enter it in larger, contiguous areas of the map. The Fill
command will change the values all contiguous cells that have the same colour as the one
that is clicked. It will give them the value selected from the legend.
This command will change the pointer in a bucket. It is identical to selecting the Bucket
icon from the Tool bar.

6.2.3

Precision Command
Use the Precision command on the Edit menu to enter detailed information on a cell by
cell basis. When a cell is clicked, a dialog will open to enter the exact value.
This command is identical to selecting the Ruler icon from the Tool bar.
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6.3.

View Menu

Use the View menu to change the manner in which the different maps of the
Micro-scale model are displayed. The first three commands on the Edit menu are
standard, but for each type of map one or more commands will be added to specify
views. These will be explained in more detail in the Map menu.

6.3.1

Go to... Command
Use the Go to... command to move the cursor to a specific location on the map. Selecting
this command from the View menu will open a dialog box requesting to enter the coordinates of the location.

6.3.2

Zoom in Command
Use the Zoom in command to increase the size of the map on your screen by a factor 2.
This command is identical to selecting the Zoom-in icon from the Tool bar.

6.3.3

Zoom out Command
Use the Zoom out command to reduce the size of the map on your screen by a factor 2.
This command is identical to selecting the Zoom-out icon from the Tool bar.

When the Micro-scale dynamics Window is the active window, the
View menu is completed with four additional commands: Show
regions, Show transportation network, Show elevation and 3D settings.
These commands allow the user to draw overlay information on top of
the Micro-scale simulation window.

6.3.4

Show regions Command
Use the Show regions command to draw (or remove) the boundaries of the regions, as
defined in the regions map, on top of the land uses in the Micro-scale dynamics window.

6.3.5

Show network Command
Use the Show network command to draw (or remove) the network, as defined in the
network map, on top of the land uses in the Micro-scale dynamics window.

6.3.6

Show elevation Command
Use the Show elevation command to change the flat land use map of the Micro-scale
dynamics window into a 3 D representation. The relief of this representation is as
defined in the elevation map.
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6.3.7

3D settings Command
Use the 3D settings command to change the manner in which the 3D diagram is
represented. When this command is selected, the user will get a Dialog box allowing him
to specify the angle of rotation, the perspective and the vertical exaggeration of the
diagram.
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6.4.

Maps Menu

Use the Maps menu to select the different maps and their respective editor that
are being used in the Micro-scale model. The land use, suitability, network
and elevation maps will open in their own windows and with their own editors.

6.4.1

Land use Command
Use the Land use command to select the land use map and its editor in the Land use
Window. With the Land use editor it is possible to change the land use map as cells can
be given a different land use.
When the land use map is selected, the Edit menu will get one additional
command named Change land use. This command allows to change the name
and colour of the land use functions. When it is selected a Change Land use
Dialog box will open.
The View menu is not changed and contains the 3 commands explained in
Section 6.3.

6.4.2

Elevation Command
Use the Elevation command to select the elevation map and its editor in the Elevation
Window. With the Elevation editor it is possible to change the elevation map as cells can
be given a different height.
When the land use map is selected, the View menu will get one additional
command named Legend. This command allows to change the classes that are
used to display the elevation of the area. When it is selected a Legend Dialog box
will open. It will request the user to enter the maximum of the highest class, the
interval of values above sea-level, the minimum of the lowest class, and the
interval of classes below sea-level.
The Edit menu is not changed and contains the 3 commands explained in Section
6.2.

6.4.3

Network Command
Use the Network command to select the network map and its editor in the Network
Window. With the Network editor it is possible to change the network as network links
and network nodes can be added to the network or removed from it.
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When the network map is selected, the Edit menu will get two
additional commands named: Accessibility parameters and Compute
accessibility.
When Accessibility parameters is selected, an Accessibility parameters
Dialog box will open which will request the user to enter a number per
land use function, reflecting the sensitivity of the function to good
access to the network.
When Compute accessibility is selected, new accessibility values per
cell and per land use function are calculated. Compute accessibility
should be invoked every time the accessibility parameters have been
changed, or when the network has been changed.
When the network map is selected, the View menu will get a
number of additional commands. These permit to change the
background colour of the network map. Backgrounds will either
be blank (White background), the actual land use (Land use, the
standard option), or the accessibility for one of the land uses.

6.4.4

Suitability Command
Use the Suitability command to select one of the suitability maps and its editor in the
Suitability Window. With the Suitability editor it is possible to change the suitability
map as cells can be given a different suitability value.
When a suitability map is selected, the View menu will get one additional
command named Show features. This command allows to display the cells
occupied by a land use feature by means of a special symbol. These cells are
not available for the allocation of functions (because they are treated as static
land uses in the model).

6.4.5

Regions Command
Use the Regions command to get a display of the Regions map in the Regions Window.
The Regions map shows the different geographical entities for which the model will
generate regional sums. The Regions map can not be changed by the user.
When the Regions map is selected, the Edit menu will get one additional
command named Indicator... When this command is clicked, a Dialog box will
open requesting the user to enter a weight for each land use. These weights are
multiplied with the total number of cells of that type and presented in the
information window which can be opened by clicking in a region. Thus, the
number of cells can be translated in another measure (i.e. if the component is
the surface of a cell in ha, the totals generated will be the area in ha taken in by
the land use function.)
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6.4.6

Potential Command
Use the Potential command to select one of the Potential maps in the Potential Window.
The Potential maps are displaying the transition potential of a cell to change to the land
use specified. It is on the basis of transition potentials that each cell will get a new land
use in the next simulation step.
When a potential map is selected, the View menu will get one additional
command named Show function. This command allows to display the cells
taken in by the land use function for which the potential is displayed on the
map. It allows the user to get an idea to what extent the land use function is
indeed present in high potential cells.
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6.5.

Rules Menu

Use the Rules Menu to view or enter the forces that specify the spatial
interaction of each possible pair of land uses.

6.5.1

(land use) Command
Select from the menu the land use function (LU1) for which you would like to enter, edit
or view its interaction with another land use (LU2). Select this other land (LU2) use by
pointing at it in the cascading menu that will open and by clicking it. As a result the
Graph editor will open. From its title bar you will read what interaction is to be entered:
‘Effect of (land use LU2) on (land use LU1)’.

6.5.2

Overview Command
Use the Overview command to get an overview of the complete set of interaction rules
defined in the model. The colours representing the different land uses are the same as
those in the Micro-scale window.
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6.6.

Simulation Menu

Use the Simulation menu to control the simulation.

6.6.1

Init Command
Use the Init command to initialise the simulation. After the model has been initialised all
the variables display the correct initial condition (values) of the model. If the Step or
Run command is selected the simulation will be automatically initialised if this has not
been done manually.

6.6.2

Step Command
Use the Step command to advance the simulation with one step. This command is
identical to clicking the Step button from the Tool bar. Once the model has been
initialised all the windows display the correct initial condition (values) of the model. If
the Step or Run command is selected the simulation will be automatically initialised if
this has not been done manually.

6.6.3

Run Command
Use the Run command to advance the simulation till the next pause tab has been reached.
This command is identical to clicking the Run button from the Tool bar. Once the
simulation is running, it can be halted by the user by selecting the Stop command from
the Simulation Menu or by pressing the Stop button from the Tool bar. The default
simulation run will take 40 years. The Macro-model and Micro-model are updated on a
yearly basis.

6.6.4

Stop Command
Use the Stop command to interrupt the simulation. This command is identical to clicking
the Stop button from the Tool bar. Once interrupted, the simulation will halt till the user
selects the Step or Run command from the Simulation Menu or till the Step or Run
button from the Tool bar is pushed.

6.6.5

Reset Command
Use the Reset command to reset the simulation to the initial state. This command is
identical to clicking the Reset button from the Tool bar. Selecting Reset will set the
simulation clock equal to 0. The state variables and maps are set equal to their initial
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values (hence the changes made during the simulation are lost); and the parameters keep
their actual value.
6.6.6

Pauses ... Command
Use the Pauses... command to set the pause tabs of the simulation. When Pauses ... is
selected, a Dialog box will open requesting the user to enter the time interval (in years)
for which he wants the simulation to halt.

6.6.7

Random ... Command
Use the Random ... command to run the simulation in stochastic mode. When Random ...
is selected, a Dialog box will open requesting the user to set a value for the εz parameter
as well as the seed value for the random generator (see Chapter 3 for more on this).
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6.7.

Options Menu

Use the Options Menu to personalise your workspace.

6.7.1

Grid ... Command
Use the Grid ... command to draw a (major) grid in the maps. When Grid is selected
from the Options menu, a Dialog box will open. The user is requested to switch on or off
the Major grid check box. Next he is to enter the size of the grid expressed in number of
cells. Finally he can offset the origin of the grid by a certain amount of cells (for
example in order to fit a reference system of some sort).

6.7.2

Font ... Command
Use the Font ... command to change the font, font style and font size of the character set
used to print the legends of maps and the informative windows.

6.7.3

Link to Excel … Command
Use the Link to Excel command to link the simulation with the Microsoft Excel
Workbook SIMLUCIA.XLS. This link is a DDE (Dynamic Data Exchange) link. Via
this link SIMLUCIA is sending model output to the Workbook while the simulation is
advancing. Note that in order to establish a successful link, it is required that Excel is
installed on your machine and that Excel appears in the PATH statement of your
AUTOEXEC.BAT. If SIMLUCIA can not find Excel, the menu option will be greyed
out. The Workbook SIMLUCIA.XLS is at the disposal of the user once the simulation is
finished. It can be used for further analysis of the simulation data.

6.7.4

Log ... Command
Use the Log ... command to store the land use maps produced by the Micro-level model
in a file. When Log ... is selected, a dialog box will open requesting the user to enter the
name of the .LOG file and the interval for which simulation results are written to the file.
.LOG files can be analysed by means of the ANALYSE utility program (see Section 7).

6.7.5

Tool bar Command
Use the Tool bar command to view or hide the Tool bar in the Applications window.
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6.7.6

Status bar Command
Use the Status bar command to view or hide the Status bar in the Applications window.

Page 62

6.8.

Window Menu

Use the Window menu to arrange the contents of the screen and to
activate one of the opened windows.

6.8.1

Cascade Command
Use the Cascade command to arrange multiple opened windows in an overlapped fashion
so that the Title bar of each window is visible.

6.8.2

Tile Horizontal command
Use the Tile Horizontal command to vertically arrange multiple opened windows in a
non-overlapped fashion so that all windows are visible.

6.8.3

Tile Vertical Command
Use the Tile Vertical command to arrange multiple opened windows side by side in a
non-overlapped fashion so that all windows are visible.

6.8.4

Arrange Icons Command
Use the Arrange Icons command to arrange the icons for minimized windows at the
bottom of the screen. If SIMLUCIA’S windows are positioned at the bottom of the
screen, then they can hide some or all of the icons.

6.8.5

Close windows Command
Use the Close windows command to close all the opened windows except for the ones
that can not be closed (in particular the Micro-scale dynamics and Macro-scale dynamics
windows).

6.8.6

List of Windows (1, 2, 3, 4, ...)
At the bottom of the Windows menu a list of open windows is presented. A check mark
appears in front of the document name of the active window. Choose a name from this
list to make the window active.
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6.9.

Help Menu
Use the Help menu to select the type of Help you want SIMLUCIA to display on
the screen. The different commands in this menu will permit to look up
information about SIMLUCIA, its commands, options, and tools.
In this version of SIMLUCIA the on-line Help is very incomplete.

6.9.1

Index Command
Use the Index command to get the opening screen of the Help file of SIMLUCIA. From
the opening screen, you can jump to step-by-step instructions for using SIMLUCIA.
Double click the topic you want help on. A Help screen will appear. Once you open
Help, you can click the contents button whenever you want to return to the opening
screen.

6.9.2

Using Help Command
Use the Using Help command for getting general instructions on how to use the
Windows Help System.

6.9.3

About ... Command
Use the About ... command to get the copyright notice and version number of the
SIMLUCIA application which you are using. The latter is important if you need
assistance with the software from the developers or when you request an update of the
software.
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7

ANALYSE

The program ANALYSE, which is also on the SIMLUCIA Demo diskette, can be used to
analyse .LOG files created with SIMLUCIA. To run ANALYSE click on the Start button
in the Windows Task bar, move to the SIMLUCIA Programs Group and finally select the
ANALYSE icon.

7.1

Basic concepts and features
A .LOG file consists of a sequence of maps generated by a simulation. The name of a
map in such .LOG file consists of the concatenation of the name of the .LOG file and the
iteration number of the simulation. With ANALYSE you are able to compare any two
maps within the .LOG file, and see the differences expressed graphically on a map as
well as in numbers presented in a table. Also the comparison of maps from different
.LOG files is possible.

The ANALYSE window has a menu bar with the menus: File, Options, Colours and
Help.
The File menu contains commands to Open and Close .LOG files, to Print the contents of
the Application Window, and to Exit. Select Open to open a .LOG file. If there is
already a .LOG file open, the program will append (up to a maximum of 42 maps) the
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maps of the newly opened file to the current list. Thus you will have the possibility of
comparing maps from different simulation runs. Select Close to close all the .LOG files
opened. Select Print to send the contents of the ANALYSE window to the default printer
using the default printer setup of your Windows environment. Select Exit to quit the
program.
The Options menu gives you the possibility to overlay a grid on the map (select Show
grid/Hide grid), to represent each cell by a circle instead of a square (select
Circle/Square), and to hide or show the legend (select Hide legend/Show legend).
The Colours menu allows you to change the colours of all the features and functions that
are displayed on the map. The Colours menu will only be accessible when maps are
displayed in the Application Window.
The Help menu only contains an About option.
Just underneath the menu bar there is a Tool bar. It contains three list boxes and four
picture buttons.
• Pushing the first button will display the map selected in the first (left) list box
• Pushing the second button will display the map selected in the second (middle) list
box.
• Pushing the third button will display differences between the two maps selected in
the first (left) and the second (middle) list box. Differences are displayed for the
land-use selected in the third (right) list box. The comparisons are made on a cell by
cell basis.

• Pushing the fourth button
will display the differences between the two maps
selected in the first and the second list box by means of a matrix-like numerical
overview.
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The Kappa statistic is a measure of the resemblance of both maps compared, globally
or per land-use.
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8. Policy exercises with SIMLUCIA
Now that the general functionality of SIMLUCIA has been covered, this chapter will
briefly describe how to run simulations with SIMLUCIA and how to use it for Decision
and Policy support. We will treat three rather theoretical exercises that get progressively
more complex and require a better understanding of SIMLUCIA.

8.1

Introduction
Policy making and more generally Decision making is a stepwise process. In order to
come to a decision, the steps are run through sequentially in one or more iteration.
Depending on the author or the literature that is consulted, the process is a subdivided in
more or less phases (or steps) and different names are given to each phase. Some
agreement seems to exist about the following three major phases, and their contents:
• the identification phase, the purpose of this phase is to better discern the real problem
which requires a decision to be taken. This is an analytical phase during which the
real origin of a problem is the topic of research, before suggestions to solve the
problem are made.
• the development phase, this is the phase during which a more or less large number of
alternative solutions for the problems are developed.
• the selection phase, is finally the phase during which the ‘least unfavourable’ solution
among all alternative solutions is searched for and selected for implementation.
Although the three phases have been discribed in a sequential order, it should be stated
clearly that decision making is very often a cyclical process, during which some if not all
of the phases are run through a number of times. The purpose of these cycles is clearly:
(1) to get an in depth understanding of the real problems; (2) to generate more and better
solutions, and (3) to decide upon an intervention or a combination of interventions that
will solve the problem, at least in part.
Full fetched Decision Support Systems (DSS) will support the decision maker in each of
the three phases mentioned. However many so-called Decision Support Systems will
focus on one or two of the phases only. For example quantitative models are used to
generate alternative solutions during the development phase, while multi-criteria analysis
is used to select among alternative solutions in the selection phase.
This version of SIMLUCIA provides support for both the first and the second phase.
SIMLUCIA will help the user to get a better understanding of the origin of problems as
they exist in St. Lucia or as they might pop-up in a more or less distant future and it will
support the user in the design and evaluation of alternative solution to cope with these
problems. The selection phase is less well supported in SIMLUCIA, since there is less
functionality built-in to compare and rank alternative solutions, other than what is
available in ANALYSE, Microsoft Excel or IDRISI.
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In the three exercises we will study the effects of external factors and policy
interventions. The exercises have been kept rather simple. Their purpose is mainly to
make you acquainted with SIMLUCIA to the point that you will be able to run your own
exercises. First we will show how to study the effects of external factors. Next we will
see how interventions of the type ‘policy interventions’ can be tested with the system.
If you intend to use SIMLUCIA for planning or policy making, you should remember that
you are working with a model and that this particular model is a strong simplification of
reality (see chapters 2 and 3). More, SIMLUCIA is an instrument intended for scientific
analysis, hence, you have full access to nearly all of its parameter and variables.
Whenever you change parameters or variables beyond their validity interval, the model
might generate results that are merely nonsense. In conclusion, use the model in a
responsible manner and with particular care !
All the exercises in this chapter will be done with the simulation files named
LucNoCh.SIM and LucRise.SIM. In the chapters 4 and 5 we have explained how to Start
SIMLUCIA, how to Open a simulation and how to Run, Reset and Exit a simulation
exercise. We assume that you know all this at this point. Begin each of the exercises
described underneath by starting SIMLUCIA.

8.2

Exercise a: Working with scenarios
The effectiveness of planning can be strongly influenced by physical, economic and
social factors external to the system. They are usually beyond the control of the planner
or policy maker. His intervention is limited to the early detection of possible dangers
caused by these factors and the design and implementation of counter measures. In order
to select appropriate and robust measures, he will introduce external factors as scenarios
in the system and study the behaviour of the system and its response to these new
conditions.
In SIMLUCIA Change in temperature and Change of the sea level are external factors,
because it is very unlikely that local decision makers can directly influence these.
Aim: In this exercise we want to examine the effects of temperature rise and sea level
rise on the loss of land and its further consequences on the tourism sector.
Screen arrangement: We will arrange the screen layout in such a manner that the input
and output windows of the model which are most relevant to this exercise are on the
display. This does not mean that the other windows are irrelevant. Because SIMLUCIA
is a highly integrated model, most state variables will undergo some changes as a result
of the exercise. Hence, feel free to dig deeper into the model to discover other effects of
the scenarios that we will simulate.
• First open the simulation file called LucNoCh.SIM;
• Minimize the Micro-scale dynamics window;
• In the Macro-scale dynamics window, click the MBB called ‘Climate’. The Climate
window will open. Move it to the left (top) side of the display;
• In the Macro-scale dynamics window, click the MBB called ‘Land use’. Move the
Land use Dialog window to the right (top) side of the screen;
• In the Macro-scale dynamics window, click the MBB called ‘Labour’. In the
Economic Sub-system dialog window, click the edit field in the column ‘Tourism’
and the row ‘Labour’. As a result a new dialog window will open named Jobs:

Page 69

Tourism. Move this window to the right side of the screen, position it below the Land
use dialog window, and click the check box left of the text Jobs. As a result a graph
will open named ‘Jobs: Tourism’;
• now minimize the Macro-scale dynamics window;
It is good practice to manage your windows very carefully. This will keep you from
being distracted. Keep only the windows opened that are of direct interest to you. All
windows and dialogs that are open are updated by the program, even if they are hidden by
other windows. This takes execution time and memory space, and thus will slow down
the program.
As a result of the above actions, your Application window should look more or less like
this:

What-if? simulation: We will compare two scenarios: the first with no climate change,
the second with a temperature rise of 2°C and sea level rise of 0.8 foot in 40 years
(between 1990 and 2030). The first scenario is a so-called ‘business as usual’ scenario
which we will use to establish a reference state, the second is a scenario which is within
the limits of scenarios presented recently (see for example: Maul, 1993)
Press the Run button in the toolbar to start the simulation. In the Climate window, none
of the values will change (as we assume no climate change in this first run). In the Land
use window you will see how the number of cells for each land use are changing. These
changes are due to the population dynamics and the external demand for goods produced
by the different economic sectors. Notice for instance how natural vegetation and forest
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is gradually losing cells as the simulation proceeds. Notice also that the tourism sector is
expanding and new cells are taken in by tourism activity. This growth is also visible in
the Jobs: Tourism dialog and graph.
When the simulation comes to a halt (after 40 years), push the Reset button. Then click
the Restore button in the title bar of the (minimized) Micro-scale dynamics window. As
a result the window will open. Run the simulation again and see how the land use is
changing. Remember that these changes are simply due to the demographic pressure and
expansion of the economic sectors. Notice for instance the fast expansion of the
industrial area near Vieux Fort and Hewanorra airport and the urbanization of the
southern tip of the island. Remember that this is the business as usual situation. The
model is showing us what is likely to happen if things are evolving purely driven by the
internal dynamics of the system (and based on the hypotheses built into the model). If
planners or policy makers are not happy with this evolution they will have to decide on
the right counter measures to stop unwanted impacts. That is how scenarios are used in
policy making.
Now we will run our second
scenario. First minimize the
Micro-scale dynamics window
again. Then select the Climate
window and click in the edit
field named ‘Temperature’ a
temperature which gradually
changes to a maximum of 2°C
in 40 years. When finished
the
Temperature
Change
window should more or less
look like this.
Now select the edit field Sea
Level and click-in a sea level
rise which gradually changes
to a maximum of 0.8 foot in 40
years
Then run this new scenario for the full 40 years. In the Climate window, you can see in
the different edit fields how the changes in temperature and sea level rise will result in a
rising storm frequency and precipitation and how this will affect (percent increase or
decrease) in the demand for Tourism, and goods in the Agriculture and Industry sectors.
Notice the difference (in comparison with the previous scenario) in the evolution of the
Jobs in the Tourism sector. Notice also in the Land use window the differences in the
number of cells that are taken in by Tourism as well as the amount of land that is lost to
the sea. If your scenario settings are similar to ours, the island will have lost 10 cells to
the sea (read the line sea with the value 0 in the column Initial land use and 10 in the
column Current land use).
If you run the simulation again with the Micro-scale dynamics window opened, you will
notice which coastal cells are lost to the sea (for example part of the causeway linking
Pigeon Island to the mainland will be lost to the sea). In the next exercise we will show
how maps can be compared more easily.
From this exercise we can conclude that climate change would have a considerable effect
on the Tourism sector. The effects in terms of land loss are rather limited. We would
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like to repeat however that the results are influenced to a degree by the assumptions built
into the model. Certainly the time series entered for the external demand of each sector
(among which the Tourism sector) will have considerable effects on the employment in
the sectors.
Also, we would like to remind you of the remark which we made about the
representation of the relief in this model (see Section 3.2). Due to the grid representation
of the relief, the typical narrow beaches of St. Lucia are not very well represented. They
tend to get disregarded because they hardly ever cover more than half of the surface of a
cell (250 by 250 meter) and their elevation above sea level is usually overestimated
(because a cell has an average elevation value). Since the calculation of sea level rise
and loss of land is directly related to the elevation of coastal cells, one should be careful
in interpreting the amount of land that is really at risk. Also, and even more important, is
the remark that SIMLUCIA does comprise models that take into consideration the effects
of waves, currents and wind on the erosion of beaches. On field trips to St. Lucia, we
have withnessed the effects on the beaches of storms in combination with seasonal
current regimes: during the winter season, beaches erode strongly, while in the summer
season, beaches are naturally replenished. In order to study these effects, SIMLUCIA
would have to be further developed and appropriate models of the kind should be
included.

8.3

Exercise b: Working with ANALYSE and MS Excel
In the chapters 4-7 we have explained that results produced with SIMLUCIA can be
further analysed by means of the programs ANALYSE and Microsoft Excel. The purpose
of this exercise is to practice this procedure.
Aim: the aim of this exercise is to re-run the simulations of exercise a, but to store the
results of the simulations on file, in order to allow for the further analysis of the results
by means of ANALYSE and Microsoft Excel. In order to be able to produce and store
Excel files, it is required that you have Excel installed on your PC.
Screen arrangement: The screen arrangement is not different from the one explained in
exercise a. Hence, make sure that your screen is organised as explained in Section 8.2.
What-if? simulation: Again we will compare two simulation runs: the No-change
scenario and the Rise scenario. Once your screen arrangement is ready to start the No(climate) change run, select from the Options menu the command Log… As a result the
Log settings dialog will open. The dialog allows you to define a so-called log-file in
which the Micro-scale dynamics maps produced by a simulation can be stored. This file
is always and immediately saved on your hard disk. Hence, there is no need for you to
save it manually.
First click the On radio-button, next
define the name of the log file in the
Log file edit field (for instance
NoCh.LOG) and finally fill in the
(simulation) interval for which you
want a map to be added to the log
file (for instance every 10 years).
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Next, we will link SIMLUCIA to Microsoft Excel and enable the transfer of simulation
data to Excel. To that end, select the Link to Excel… command from the Options menu.
As a result the default Excel file LUCIA.XLS will open. This workbook file is now
ready to receive data from the simulation. Click in the SIMLUCIA application window to
bring it back to the foreground of your screen.
Now start the simulation. The dialogs will be updated and, hidden from the user, maps
are written to the log file NoCh.LOG (at every 10th simulation step) and to the workbook
LUCIA.XLS (at every simulation step). When your simulation comes to a halt (at
simulation step 40) select the workbook and save it as NoCh.XLS.
At this point we will not further discuss the results of the simulation as they are not
different (except for some effects due to the probabilistic variables) from what has been
said in exercise a. We will immediately continue the exercise with the second
simulation. However, do not change the Temperature rise and Sea level Rise by hand,
rather select from the File Menu the command Open Simulation to open the simulation
file named Rise.SIM. This file is identical to the NoCh.SIM except for the fact that a
climate change scenario (2°C Temperature rise and 0.8 foot Sea level rise in 40 years) is
pre-defined.
When Rise.SIM is opened, the old simulation will close automatically. None of its
output is saved, except for the NoCh.LOG. A dialog will open asking you whether you
want to save the simulation results. If you answer yes, the Save as dialog will open.
Answer No.
Once Rise.SIM is opened, make certain that the maps produced by the Rise scenario are
written to the LOG file named Rise.LOG for every 10th iteration. Also, select Link to
Excel again in order to open a new (empty) workbook LUCIA.XLS to receive the results
of the Rise scenario.
Then, start the simulation and run it for 40 years and save LUCIA.XLS with the new
name RISE.XLS.
Comparison of simulation results: We will compare the results of both simulations: to
compare maps, we will use the application ANALYSE, and to compare numerical results,
we will use Microsoft Excel..
Open ANALYSE (consult Chapter 7 for more details). If you installed SIMLUCIA as
explained, it should be located in the same Program Group. Next, select from its File
menu the Open… command to open the file named NoCh.LOG. As soon as the program
has opened the file, it will display the first map of the file. Maximize the window to
increase the map to the maximum size possible (on your monitor).
Next select again from the File menu the Open… command. Now open the file named
Rise.LOG. ANALYSE will ask you whether you want to close the current (= NoCh.LOG)
log file(s). Answer No to this question and select Rise.LOG in the Open dialog. From
this moment on, ANALYSE is ready to show you any of the maps stored in both log files
and to perform a comparison between any two maps. Let us compare the end states of
both simulations. To that end select in the first list box (from the left) the map NOCH40
and in the second list box the map RISE40. Then press the comparison
button.
ANALYSE will now show the results of a cell by cell comparison between the two maps
and for each land use. In the third list box you can select the land use for which you
want to see the comparison.
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Pick Sea from the list of land uses. In green you see which cells are taken in by the sea
in both simulations and in blue you see the 10 cells that are lost to the sea due to sea level
rise.
Now pick Tourism from the list of land uses. Again in green you see cells that are taken
in by tourism in both simulations, in red the cells which land use has changed due to sea
level rise and in blue cells that are taken in by tourism in the Rise scenario, but not in the
No change scenario. To understand better the overall changes that have taken place in
the vicinity of some of the red or blue cells, it is interesting to look at the original maps
that are being compared by pressing the buttons or . There is an interesting case of
coastal retreat to be seen in the Rodney Bay area. Some cells are lost to the sea, the
beach has moved inland, and some tourism cells have been abandoned. Of course, the
simulations are showing what would happen in the absence of beach protection by public
or private authorities. Also, land loss and beach loss in our simulation depend largely on
the elevation map, which has only one elevation reading per cell (250 by 250 m).
The numerical results of both simulations can be compared and further analysed by
means of Microsoft Excel. Excel is a very elaborate package with almost unlimited
capabilities. One way of comparing two simulation runs is to open both .XLS files that
have been generated and stored (in our case NoCh.XLS and Rise.XLS) and to create a
new (a third) Workbook in which the comparisons (differences) are calculated. Excel
will also allow to make graphs of the simulation results. However, it is beyond the scope
of this chapter to explain the functionality of Excel.
We would like to conclude this exercise with the remark that SIMLUCIA also supports
the Export of its maps to IDRISI (as .IMG files). In IDRISI they can be further
compared, analysed and manipulated. This too is beyond the scope of this chapter.

8.4

Exercise c: Working with policy interventions
In the previous exercises we worked with scenarios, which we defined as hypotheses
related to external factors not under the control of the decision maker. Other parameters
in SIMLUCIA can be controlled by planners and decision makers. To mention are the
demographic parameters that define the long term trends in birth, death and the migration
rates. Decision makers can influence these parameters at the least in part through
information campaigns, education, and/or health programmes. The same is true for the
economic parameters. For example, a directed promotion campaign abroad for a product
produced in St. Lucia (say tropical flowers) could boost the exports of the Agriculture
sector. Finally decision makers can restrict the spatial expansion of particular sectors in
specific parts of the island through zoning regulations. We define this type of
interventions as policy interventions. The next exercise will demonstrate how SIMLUCIA
can be used as an instrument for land use planning, possibly watershed management. We
will show how a zoning regulation can be introduced in the simulation and how the
effects of such regulation can be analysed. It is an exercise that will reveal the real
dynamic capacity of SIMLUCIA.
Aim: The particular aim of the exercise is to protect a remnant of forest which is located
South of Forestière and North of Floissac on the lower slopes of Piton Flore and drained
by a tributary of the Cul de Sac River. On the Land Use and Vegetation map in the Atlas
of St. Lucia the forest is marked as Secondary Natural Forest (= Land that was cleared
for agriculture or forest products and has since reverted to forest). On the SIMLUCIA
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Land use map, the forest consists of 10 cells (= 62.5 ha) located around cell [row = 67,
column = 66].
Screen Arrangement: In this exercise we will work with the maps of the Micro-scale
models. If your PC is equipped with a low resolution monitor, you will have to keep the
maps sufficiently small (or zoom out) to see them simultaneously on your screen. As
part of the exercise, we will edit maps. Please keep in mind that SIMLUCIA is not
equipped with a so-called Undo edit function. This means that corrections made to maps
are definite. You can press the Reset button to reverse all the corrections made since the
simulation was opened. Be careful when you save the simulation not to overwrite
original maps with copies that have been edited by you (read the instructions in Chapters
3-6).
• Start SIMLUCIA and Open the simulation file named ‘NoCh.SIM’. Close the Macroscale dynamics window.
• Select from the Maps menu the Suitability map for Agriculture.
• Zoom in on both maps to the point that the cells are sufficiently big to allow you to
click-in new values.
• Position the maps in such a manner that the area around the cell with the co-ordinates
[row = 67, column = 66] is handy. In order to find cell [row = 67, column = 66] you
can select from the view menu the command Goto… and fill in the co-ordinates.
• In order to focus your attention on the area where we will intervene, it helps to show
the Major Grid on top of both maps. To that end, select Grid… from the Options
menu and draw a Major Grid every 4 cells.
• Finally, make the Micro-scale dynamics window active (by clicking it) and select
from the View menu the command Network in order to draw the road system on the
map.
• Your screen should now look more or less like this:

Forest location

Forest location

Page 75

What-if? simulation: For the sake of the exercise we assume that we have the power to
impose zoning plans. With SIMLUCIA, we want to find out why the particular forest area
is threatened, what type of land use is likely to replace the forest, when will this happen
and how rigorous should the zoning regulation be that is to prevent the forest from
vanishing.
• First, run the simulation and watch carefully what is happening to the forested area.
Mark when forest cells disappear. What is replacing the forest ? Reset and re-run the
simulation if everything goes to fast for you. In the end you should have concluded
that the forest entirely disappears and that it is replaced by agriculture. The first
forest cell disappears around the third year, and the last is gone after about 35 years.
All cells are taken in by agriculture. Notice that the first cells disappear near the road,
where the Accessibility is highest. Check the latter by selecting the Network map
from the Maps menu and Accessibility for Agriculture from the View menu. Clearly,
the increasing demand for agricultural products, due to both the growing local
population and the export markets is putting a lot of pressure on the land. Agriculture
is gradually taking in more land all over the island and also in our forest area. This
you can check by running the simulation again while you zoom in on other locations.
If you want to know how many cells are taken in by agriculture, you can double-click
the left mouse button in the Micro-scale dynamics window to open an overview
window showing the number of cells of each kind at each simulation step. Notice
also the fact that while the forest disappears, the rural residential area just West of the
forest expands, and that the expansion of Castries to the South adds to the general
pressure on the land in this part of the island.
• Next, we will try to stop the farmers from entering our forest by imposing a zoning
regulation. This can be done by means of the suitability map. As explained in
Chapter 4, a suitability map is the expression of the capacity to support a particular
land use. On your screen you have opened the suitability map for agriculture. Hence,
for each cell you can read how well suited it is for agriculture. In the Suitability
calculation (See Chapter 3 and Annex D) we have considered a number of factors,
including actual use, land capability, slopes, elevation, rainfall, etc. But suitability
also involves institutional aspects, such as zoning plans. Hence, the planner can in an
artificial manner lower the (physical) suitability to represent institutional regulations.
• Read form the Suitability map the suitability value for the forest cells. To that end
move the cursor over the cells. Do not click the mouse, if not, new values will be
entered in the cells.
Another way of knowing the
accessibility values is by clicking the
right mouse button on a forest cell in
the Micro-scale dynamics window. A
window will pop-up which shows all
the information that is available for
this particular cell, among which the
Suit(ability) for Agriculture.
You will read that the suitability value
for the forest cells is 0.7 on a (0.0 1.0)-scale.
• The policy maker could lower this suitability value by introducing zoning regulations.
Entering a value of 0.0 would mean a very strict regulation, which would definitely
and absolutely protect the forest from intrusion by agriculture, but which would be
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very expensive and difficult to enforce. The least costly and simplest to enforce
would be a policy intervention which will reduce the suitability from 0.7 to 0.6.
• Try out the latter. To that end, reset the simulation and click a suitability value of 0.6
in all (10) or some of the forest cells. Then run the simulation again. Are the cells
still taken in by agriculture ? Keep on lowering the suitability value till the complete
forest area can withstand the pressure from agriculture for the full 40 years. Notice,
that the policy maker could reduce the cost of his intervention by fine-tuning the
timing of his interventions. To that end he has to lower the suitability of a cell only
the year before it is threatened by agriculture. Thus the surveillance and other costs
could be reduced.
• Now that you have been able to stop agriculture from taking in our forest, it is
interesting to know where farmers will have found an alternative area to expand their
activities. To that end, use the technique explained in the previous exercises. Run a
simulation without policy intervention and the one where the forested area remains
untouched by agriculture. Put the results on .LOG files and compare them by means
of ANALYSE. Notice that the policy intervention has consequences for the location of
agriculture, but that other activities, due to their links with agriculture, have been
affected as well. Possibly the policy intervention has effects that are even worse than
losing the 10 forest cells, and possibly the policy maker has to decide on additional
measures to control agriculture, or any other activity for that matter. It is up to you to
try this out from here.
Many more exercises of the kind explained could be tried out with SIMLUCIA. We could
have studied what effects the construction of new roads has on the location of specific
land uses, we could have experimented with measures to stop the expansion of Castries
to the North, or to the South. We could have tried how to divert some of the growth of
Castries to the Vieux Fort area, etc. We hope however that these 3 exercises have made
you acquainted with SIMLUCIA to the point that you can start experimenting on your
own.
Remember that the prime role of SIMLUCIA is to give you a better insight in the linked
non-linear dynamics of socio-economic systems and the consequences of growth on a
limited resource such as land. Further to show you how these dynamics could be
affected by climate change. SIMLUCIA will not predict the exact future of St. Lucia. It
is much too simple a model to do so. The best it can is to calculate and visualise what
sort of alternative futures are possible and what the role of different social, economic and
spatial actors is in all this. As such it is a formal discussion platform: it will calculate
effects in a consistent and consequent manner. Thus, it should assist in awareness
building and education generally and it should support policy makers and analysts in
making better informed decisions in particular.
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ANNEX A: GEONAMICA Simulation Environment
SIMLUCIA has been developed by means of the simulation environment
GEONAMICA. GEONAMICA features an Object-Oriented (O-O) simulation
language, which enables to build a wide variety of models linking component sub-models
at the Macro-scale and the Micro-scale and representing the economic, demographic and
natural sub-systems in a network of mutual and reciprocal influence. The simulation
objects are the so-called Model Building Blocks MBB’s. MBB’s are more or less
complete models. They vary from simple mathematical operators, such as Multipliers or
Adders, to rather sophisticated and nearly complete models consisting of coupled
mathematical equations performing a number of sophisticated calculations.
A Model Building Block represents a part of a model: an action or process. Each MBB
is represented by means of a unique graphical object that shows how the MBB relates
and is connected to other MBB’s in the model. From this connection scheme, the MBB
knows where it has to get its information from, and where it should send its information
to. MBB’s may simply represent sources of information (i.e. entered from file or by the
user), other will transform information as it passes through them, and still other will
simply serve to communicate, in a synthetic manner, the outputs of the model to the user.
Despite the fact that all these MBB’s play different roles in the model, in ObjectOriented jargon, they are all ‘children’ of the same ‘parent’, which is a MBB with the
basic capability of exchanging and transforming information.

Model Building Block

Out-Connector

In-Connector

Connection

Next to the Model Building Blocks, GEONAMICA’s simulation language features a
number of additional primitives: Libraries where the MBB’s are stored and where they
are selected from; In-Connectors through which MBB’s obtain data from other MBB’s;
Out-Connectors through which MBB’s send out their information for use in other
MBB’s; Connections that link the MBB’s; Dialogs through which the MBB’s
communicate with the user; and a Documentation page that contains the technical
specifications of the MBB.
Connectors and Connections.
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In-Connector
Out-Connector

Connection

Variables and parameters can be passed from one MBB to the other via
Connections, or Pipes. MBB’s will dispense variables or parameters with
the rest of the model via Out-connectors, and will take-in information
from other MBB’s via In-connectors.
The actual exchange between MBB’s is possible when a Connection (or
Pipe) is drawn between an Out-connector of the issuing block and the Inconnector of the receiving block. For each variable or parameter that is
being exchanged, one connection is drawn (except if one of the MBB’s is
a SuperMBB) in the diagram.

A model block has a so-called In-Side and an Out-Side. The In-Side is where the InConnectors are placed, the Out-Side is where Out-connectors are placed. The user can
decide which of the four edges of the MBB are the In- and Out-Sides. The only
limitation is that they should never be on one and the same edge.
Each MBB has a dialog box attached to it. This dialog box is the vehicle that permits the
interactive exchange of information between the user and the Model Building Block.
The MBB will communicate the results (output) of its numerical operations to the user
and it will accept the data entered (input) by the user that are required for the execution
of the MBB. It concerns data that are internal to the MBB and which it does not get from
other MBB’s via its In-Connectors.
Model results and model inputs are presented in Edit Fields. The difference between
input and output fields is indicated by the colour of the text in the edit field: green for
state variables (to be entered as initial values and for the remainder output of the MBB);
purple and blue for intermediate variables; black for variables or parameters copied from
other MBB’s (output of the MBB); and finally red for internal parameters of the MBB
(input for the MBB).
Colour of text in the
Edit Fields of
MBB-Dialog Boxes
RED
PURPLE

GREEN
BLUE
BLACK

Description
Input. Parameter value (can be changed during the entire
simulation) or State variable at the initial state.
Input. Variable value. If the edit field is clicked, a dialog will
pop-up requesting input necessary for the calculation of the
variable
Input / Output. State variable which can be changed at the start
of the simulation, and which display output for the remainder.
Output. Variable value. (read-only)
Output. Values copied from other MBB’s. (read-only)

Entering data in dialogs is done in a manner which will support and protect the user to a
certain extent. Each edit box in a dialog window knows what type of data it is to get
from the user: a single number, an array of numbers, or a table (i.e. time series). For
each type the appropriate editor is opened when the user clicks in the edit box.
Each MBB has its Documentation page in the Documentation system. It is accessible
when the dialog window of the MBB is opened (by pressing the F1-key or clicking in the
dialog window by means of the Context Sensitive Help cursor). This Documentation
page gives technical information about the MBB. It can include the mathematical
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expression, scientific references, the specification of the In- and Out-Connectors, the
units in which values are displayed, etc.
Libraries are repositories of MBB’s. The entire definition of the MBB (its C++ code, its
graphical representation, its dialog, and its documentation page) are stored in the Library.
When a MBB is included in a model, the block itself is not copied to the model, rather a
reference to the block in the library is made.
SuperMBB’s group a number of connected MBB’s, thus constitute a sub-model. They
are introduced to keep the representation of the model structured and clear.
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ANNEX B: Estimation of the Input-Output Table

I.

Introduction
These notes describe the sequential steps followed in constructing the I-O table for 1990.
The numbering of the notes corresponds to the numbers shown on the I-O table. The
table has been prepared in June 1996 with data available at that time. The data used is
from the following sources:
ref. 1. Ministry of Agriculture, Lands, Fisheries and Forestry: Annual Agricultural
Statistical Digest 1992 (ADD vol. 10)
ref. 2. Government Statistics Department: National Accounts 1977 to 1992.
ref. 3. Government Statistics Department: Annual Statistical Digest 1991.
ref. 4. Selected Tourism Statistics. (one page).
ref. 5. St. Lucia Stay Over Visitors Survey - Summer 1995 (Table: St Lucia Stay Over
Visitors Expenditure)
These sources provide essentially all of the data required to construct the I-O table except
for the individual inter-industry flows; however, inter-industry row and column totals
can be derived from the data. The resulting table is highly constrained by the data,
except for the interior of the inter-industry part. Where it is possible to make cross
checks by comparing calculated with published values, or by comparing values
calculated following two different approaches, the agreement is good: differences are
always less than 3.5%. The table is constructed from 1990 data.

A. AGRICULTURE
(notes)
B. INDUSTRY
C. TRADE

a
AGRIC
5

b
INDUST
30

c
d
e
TRADE SERVICE TOURISM
10
2
5,3

20

250

75

30

50,3

5

20

40

50

67,5

D. SERVICE

6

30

30

20

46

E. TOURISM

0,2

2,8

0,4

1,3

139,8

f
g
h
i
j
k
l
m
TOTALS HSEHOLD CAP.FOR
GOVT DOM.DEM EXPORTS FIN.DEM. TOTALS
52,3
73
194,5
267,5
319,8
n1
n18
n15
n14
n7
425,3
649,5
149,2
798,7
1224
n1
n18
n16
n14
n7
182,5
135,4
0
135,4
317,9
n1
n18
n16
n14
n7
132
370,2
22,3
392,5
524,5
n1, n10
n18
n16
n14 n7,n9,n13
144,5
0
415,4
415,4
559,9
n1, n11
n18
n8
n14
n12
936,6
748,3
276,6
170,8
1228,1
781,4
2009,5
2946,1
ref.2 p.35 ref.2 p.35 2p.35,n19
n19
n17
n20
932,2

F. TOTALS
(CORRECTED)
G. DOM. FINAL
FACTOR INPUTS
H.

36,2
n52
124,8
n53, n45

332,8
155,4
n52
n52
315,2
143,9
n53, n45 n53, n45

103,3
n52
227,1
n53, n46

308,9
n52
122,2
n53, n47

I. NET INDIRECT
FINAL FAC. INPUTS
J. TOTAL DOM. FIN
FACTOR INPUTS
K. IMPORTS

18,7
n48
143,5
n54, n49
140,1
n40
283,6
n55, n50
319,8
n51

71,6
18,6
n48
n48
386,8
162,5
n54, n49 n54, n49
504,4
0
n41
n42
891,2
162,5
n55, n50 n55, n50
1224
317,9
n51
n51

30,7
n48
257,8
n54, n49
163,4
n43
421,2
n55, n50
524,5
n51

32,8
172,4
n48
155
1105,6
n54, n49
n56
903,5
95,6
n44 (calculated)
2009,2
250,6
n55, n50
2946,1
559,5
n51

L. TOTAL FINAL
FACTOR INPUTS
M. TOTALS

N. EMPLOYMENT

11666

O. PRODUCTIVITY
123000,7
(n74)

15174
6720
9958
5603
n71, n74
n71,73,74 n71,72,74
25490,97 24181,55 25888,73 27663,75

49121
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902,6
(ref2,p.35)

II.

Derivation of the Output (or Demand) Side of the Table
1. Row totals for inter-industry sales are from ref.2 p.29 but adjusted upward to account
for unallocated imputed banking service charge found in the same table: this is allocated
in proportion to sector size:
r = 881.02 / (881.02 - 52.03) = 1.063
Agric. = r (49.15) = 52.3
Industry = r (mine & quar + mfg + const + E&W + transp & comm)
= r (7.6 +164.8 + 111.6 + 38.0 + 56.2 + 22.1) = r (400.1) = 425.3
Trade = r (171.7) = 182.5
Services = r (fin. + RE + govt + oth. serv)
= r (19.5 + 4.5 + 50.9 + 69.3) = r(144.2) = 153.3
Tourism = r (ho&re) = r (115.9) = 123.2
Amounts for services and tourism are further adjusted in (10) and (11) below.
2. Imports of agriculture from ref.1 p.62.
3. Imports of Industry:
merchandise debit from ref.3 p.87 less Agric. imports from ref.1 p.62
= 644.5 - 140.1 = 504.4
4. Imports of Trade: assume none.
5. Imports of Services: from ref.3 p.87, debit column:
shipping + other transp. + other goods, serv, inv.
= 87.9+ 33.6 + 91.9 = 213.4
6. Imports of Tourism: ref.3 p.87 : travel (debit) = 45.6
7. Totals: the figures shown in ref.2 p.28 evidently are total sectoral output net of imports
(note for example that total output shown for agriculture is less than agricultural
exports); i.e. the totals are those required for calculating GDP, rather than true totals.
Thus to get actual total sectoral outputs, it is necessary to add imports:
Agric: 179.7 +140.1 = 319.8
Industry: (mine & quar + mfg + const + E&W + transp & comm) + imports
= (12.8 + 237.7 + 172.6 + 61.8 + 160.2 + 75.6) + 504.4 = 1224.0
Trade: 317.9 + 0 = 317.9
Services: (shipping + other transp. + other goods, serv, inv.) + imports
= 93.9 + 53.7 + 173.9 + 99.0) + 213.4 = 633.9 (This total is further adjusted in (10)
and (11) below).
Tourism: calculated in (12) below.
8. From ref.4 “total expenditures”; assume this entire amount constitutes exports:
= 415.4
9. Tourism exports as defined by Travel (credit) in ref.3 p.87 = 326.6 compared with
amount shown in (8) above. 326 / 415.4 = 78.6 %. Compare this ratio with that in ref.5
which shows hotel and meals & drinks expenditures at 72.5% + 6.3% = 78.8%. Thus the
Horeca sector seems to account for this proportion of tourism. Therefore adjust other
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sectors so that in total they lose an amount equal to 21.2% of Tourism exports. For want
of data, assume all of this is reallocated from Total. Output of Services as calculated in
(7) above: 633.9 - 0.212 (415.4) = 633.9 - 88.1 = 545.8; this figure is further adjusted in
(13) below. The 88.1 reallocated from Services is already included in Tourism exports
as defined in ref.4.
10.Since some of the Services sector is reallocated to Tourism, adjust the inter-industry
totals from (1) accordingly by an amount calculated from the proportional decrease of
services: (545.8 / 633.9) (153.3) = 132.0
11.Increase the Tourism inter-industry total by the amount transferred from Services:
123.2 + (153.3 - 132.0) = 144.5
12.Tourism Total = inter-industry total +exports + 144.5 + 415.4 = 559.9
13 Services Total Output is adjusted downward by the amount of inter-industry sales
transferred to tourism in (11): 545.8 - (153.3 - 132.0) = 524.5
14.Sectoral Final Demand (col. l) = sectoral Total Output (col. m) less sectoral total of Interindustry sales (col. f).
15.Agric. exports from ref.1 p.5.
16.Other exports:
Industry: merchandise credit (from ref.3 p.87) less Agric. exports (15).
= 343.7 - 194.5 = 149.2
Trade: assume exports = 0.
Services: from the credit column of ref.3 p.87, (ship + other transp + other goods, serv,
inv) less transfer to Tourism from (9) above
= (0.1 + 35.4 + 74.9) - 88.1 = 22.3
17.CROSS CHECK: the total of the exports column (k) is 781.4 compared with the
published total in ref.2 p.35 of 778.2, a difference of 0.411%.
18.Domestic demand (col j) = Final Demand (col l) less Exports (col k).
19.CROSS CHECK: compare calculated total domestic demand of 1228.1 with published
totals from ref.2 p.35: (households + cap. form. + govt.) = (748.3 + 276.6 + 170.8) =
1195.7; the difference is 2.71%
20.CROSS CHECK: Calculate GDP at market prices as total output less total imports (from
ref.2 p.35) = 2009.5 - 902.6 = 1106.9; compare with published figure of 1071.3 (ref.2
p.35). The difference is 3.32%.

III.

Derivation of the Input (or Supply) Side of the Table
Note:

• numbers 21 - 39 are not used
• results of operations 40 - 52 are shown in the table below

40.Imports of Agric from ref.1 p.62.
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41.Imports of Industry: merchandise debit (from ref.3 p.87) less Agric imports (40)
= 644.5 - 140.1 = 504.4
42.Imports of Trade: assume none.
43.Imports of Services: from ref.3 p.87, debit col., (shipping + oth. transp. + oth. g,s,i) less
reallocation to Tourism
= (87.9 + 33.6 + 91.9) - 40 = 173.4.
Note that the amount reallocated to Tourism is arbitrary because of lack of data. But the
total reallocation on the input side carried out in (43) and (46), and implicitly in (48), is
approximately equal to the reallocation on the output side in (9, 10, 11 and 13).
44.Imports of Tourism: travel debit from ref.3 p.87 plus reallocation from services:
45.6 + 40 = 85.6
45.Domestic factor inputs from ref.1 p.5 or ref.2 p.17 and adjusted in proportion to sector
size to exclude imputed banking service charge by the factor
r = 898.92 / (898.92 = 52.0) = 0.9453
Agric: r (130.6) = 123.5
Industry: r (mine & quar + mfg + const + E&W + trnsp & comm.)
= r (5.14 + 73.00 + 61.00 + 23.80+ 104.00 + 53.55) = r (320.5) = 303
Trade: r(146.2) = 138.2
46.Domestic factor inputs (Services): (fin + RE + govt + oth serv) from ref.2 p.17 less
reallocation to Tourism (assumed, but see (43)), and then adjusted by r (see (45)):
= r ((74.37 + 49.18 + 123.0 + 29.7) - 40) = 223.3
47.Domestic factor inputs (Tourism): Ho & Re. from ref.2 p.17 plus reallocation from
services, then adjusted by r (see (45): r (77.4 + 40) = 111.0
48.Total net indirect taxes and subsidies from ref.2 p.35 are allocated to sectors in
proportion to sectoral Total outputs: r = 172.4 / 2946.1 = .05852
49.Total domestic final factor inputs are calculated as the sum of domestic factor inputs (45,
46, 47)and indirect taxes.
50.Total direct inputs are calculated as the sum of total domestic final inputs (49)and
imports.
51.Since total sector inputs for each sector must equal total sector outputs, set input totals
(row M) equal to output totals (col. m).
52.Inter-industry totals (row F) are calculated as total inputs (row M) less total final factor
inputs (row L). But the total of inter-industry purchases thus calculated is 971.2
compared with the 936.6 total calculated for inter-industry sales in col. f. Since the interindustry sales are taken from actual data (with adjustments), the purchases figures should
be re-scaled so that total inter-industry purchases are equal to total sales. Thus apply a
correction factor r = (936.6 / 971.2) = 0.9645 to each inter-industry purchase total to get
the final values used in the I - O table. Differences between the preliminary and final
figures are shown in the corrections row of the table below.
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53.Add the amounts subtracted from the inter-industry totals (shown in the corrections row)
to the domestic final factor inputs, since total sectoral inputs must remain unchanged, and
the original over-estimation of the inter-industry totals must be due to an underestimation
of final factor inputs.
54.Recalculate total domestic final factor inputs: row J = row G + row I.
55.Recalculate final factor inputs: row L = row J + row K
56.CROSS CHECK: Total of domestic final factor inputs as calculated here (i.e. including
net indirect taxes and subsidies)--1105.6--is an estimate of GDP at market prices.
Compare with the published figure of 1071.3 from ref.2 p.35. The difference is 3.22%.

IV.

Derivation of the Inter-Industry Portion of the Table
Note: • numbers 57-59 are not used.
60.Au goût, as long as row and column totals of the inter-industry portion are respected.
Table 1. Preliminary figures for the supply sectors.

(F) Total inter-industry
(G) Domestic factor input
(I) Indirect taxes & sub.
(J) Total dom. factor inputs
(K) Imports
(L) Total direct inputs
(M) Total inputs
(FF) Corrected values for row (F)
Corrections for row (F)

V.

Agric
37.5
123.5
18.7
142.2
140.1
282.3
319.8
36.2
1.3

Indus
345.0
303.0
71.6
374.6
504.4
879.0
1224.0
332.8
12.2

trade
161.1
138.2
18.6
156.8
0
156.8
317.9
155.4
5.7

Service
107.1
223.3
30.7
254.0
163.4
417.4
524.5
103.3
3.8

tour
320.5
111.0
32.8
143.8
95.6
239.4
559.5
308.9
11.2

Note on Employment and Productivity
Row J of the input output table shows the total remuneration to domestic factors of
production by sector, i.e. total payments (direct and imputed, including all wages,
salaries, tips, bonuses, rents, dividends, and undistributed profits) to Labour, Capital, and
Land. These earnings may be associated with employment using data from Table 4.8:
Employment by Sex by Industry Groupings - 1991 (loose page in papers sent Guy
from St. Lucia).
71. Combine the sectors into the five used in the I-O table as follows:
Agriculture:
Industry: Mining etc.
131
Manufacturing
6751
Utilities
575
Construction
4960
Transport & Comm. 2669

Page 86

11598

15086
6681

Trade:
Services: Finance
Real Estate
Public Administration
Other Services

982
948
6586
2562
11081
4389

Hotels and Restaurants:
72.Estimate Tourism employment as
HoRe / 0.788 (see 9 and 43 in I-O Notes): 4389 / .788 =

5570

73.Re-calculate Services assuming all employment re-allocated to
Tourism came from this sector: 11081 - (5570 - 4389) =

9900

74.Allocate the 286 sector “not stated” employees in Table 4.8 in proportion to sectoral
employment, and use the domestic factor payments from row J of the I-O table to
calculate productivity per employee:
Table 2. Employment and Productivity
Sector
Agriculture
Industry
Trade
Services
Tourism

Employment
11666
15174
6720
9958
5603
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Productivity Per Employee (EC$)
12300.70
25490.97
24181.55
25888.73
27663.75

ANNEX C: Factors and Weights
This annex contains an overview of the factors and weights that have been used in the
overlay analysis to produce the set of suitability maps used in SIMLUCIA.
A

4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65

B
C
D
E
F
G
H
I
J
factor
Rating per land use function
type
Industry Services
Rural
Urban
map: reluse
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
Sea
1
0
0
0
0
0
0
0
0
Primary Forest
2
2
2
1
0
0
0
0
10
Secondary Forest
3
4
3
2
1
1
1
0
8
Scrub Forest
4
6
4
4
1
1
2
1
6
Open Woodlands
5
8
6
4
2
2
2
1
4
Grasslands
6
6
7
5
3
3
3
2
2
Large-Scale Agriculture
7
6
8
5
4
4
4
3
4
Intensive Small Farming
8
5
9
6
7
4
7
5
5
Mixed Small Farming
9
4
7
5
5
4
6
4
6
Rural Settlemant Areas
10
4
6
7
8
6
10
8
4
Urban, Commercial, Industrial an
11
2
4
9
10
7
6
10
0
Factor 1: Land Use Atlas

Factor 2: Land Use Actual
map: landuse
Natural vegetation
Agriculture
Industry and Quarries
Trade and Services
Tourism
Rural residential
Urban residential
Forest
Forest reserve
Mangrove
Sea
Beach
Coral reef
Terminals, ports, airports
Infrastructure

Factor 3: Land Tenure
map: reldis
Sea
Undivided Government
Partly Subdivided Government
Fully Subdivided Government
Para-statal Land
Forest Reserve
Undivided Private
Partly Subdivided Private
Fully Subdivided Private
Other
Settlements

Factor 4: Land Capability
map: relcap
Sea
Suitable Class I
Suitable Class II
Suitable Class III
Suitable Class IV
Not Suitable Class V
Not Suitable Class VI
Not Suitable Class VII
Not Suitable Class VIII
Settlement

factor
Rating per land use function
type
Industry Services
Rural
Urban
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
1
10
8
4
4
6
6
6
5
2
6
10
6
6
6
8
7
4
3
8
5
10
8
4
5
7
2
4
8
3
6
10
7
6
9
2
5
8
5
6
8
10
4
9
2
6
6
8
5
7
5
10
8
4
7
6
2
8
9
7
6
10
4
8
5
6
5
4
6
7
5
10
9
2
0
0
0
0
0
0
8
10
6
3
0
0
0
3
1
4
11
0
0
0
0
0
0
0
0
12
8
3
4
0
9
0
2
2
13
0
0
0
0
0
0
0
0
14
6
0
9
8
8
2
7
4
15
4
0
2
2
2
3
2
6
factor
Rating per land use function
type
Rural
Urban
Industry Services
Forest
Tourism
Natural Agriculture
residential residential
Quarries
Trade
1
0
0
0
0
0
0
0
0
2
4
4
4
4
4
2
2
6
3
4
6
5
5
5
4
4
6
4
6
8
6
6
6
6
6
4
5
6
8
6
6
6
6
6
4
6
2
0
0
0
0
0
0
8
7
7
8
6
6
6
6
6
3
8
7
8
8
8
8
8
8
3
9
8
8
9
9
9
10
10
2
10
5
8
8
8
8
9
9
5
11
8
4
6
6
6
8
10
2

factor
Rating per land use function
type
Industry Services
Rural
Urban
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
1
0
0
0
0
0
0
0
0
2
1
10
5
6
6
9
9
1
3
2
8
6
5
5
8
8
2
4
3
6
7
4
4
7
7
3
5
4
5
7
4
4
6
6
4
6
5
4
6
3
3
5
5
5
7
6
3
6
2
2
4
4
6
8
8
2
6
1
1
2
2
8
9
10
1
5
1
1
1
1
10
10
8
4
6
6
6
8
10
2
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A
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127
128
129
130

Factor 5: Life Zones
map: relzone
Sea
Tropical dry - very dry forest
Tropical dry forest
Tropical moist forest
Subtropical moist forest
Subtropical wet forest
Subtropical wet - rain forest
Subtropical rain forest
Settlement

Factor 6: Rainfall
map: rsurface
Sea
< 1520 mm
1520 - 1778 mm
1778 - 2032 mm
2032 - 2286 mm
2286 - 2540 mm
2540 - 3045 mm
3045 - 3810 mm
> 3810 mm

Factor 7: Slopes
map: slopec
Sea
< 2.5 %
2.5 - 5.0 %
5.0 - 10.0 %
10.0 - 17.5 %
17.5 - 25.0 %
> 25.0 %

Factor 8: Land Elevation
map: elevat
Sea
< 25 feet
25 - 50 feet
50 - 100 feet
100 - 200 feet
200 - 400 feet
400 - 600 feet
600 - 800 feet
800 - 1000 feet
1000 - 2000 feet
> 2000 feet

B
C
D
E
F
G
H
I
J
factor
Rating per land use function
type
Rural
Urban
Industry Services
Forest
Tourism
Natural Agriculture
residential residential
Quarries
Trade
1
0
0
0
0
0
0
0
0
2
8
4
8
8
9
4
8
2
3
7
6
7
7
8
6
7
3
4
6
8
6
6
7
8
6
4
5
5
6
5
5
5
7
5
5
6
4
8
4
4
4
8
4
6
7
2
6
2
2
2
6
2
8
8
0
2
0
0
0
2
0
10
9
8
4
6
6
6
8
10
2
factor
Rating per land use function
type
Industry Services
Rural
Urban
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
1
0
0
0
0
0
0
0
0
2
10
4
9
9
9
8
9
1
3
9
6
8
8
8
10
8
3
4
8
8
7
7
7
8
7
5
5
7
9
6
6
6
7
6
6
6
6
6
4
4
4
6
4
7
7
5
4
2
2
2
4
2
8
8
3
2
1
1
1
2
1
9
9
1
0
0
0
0
0
0
10
factor
Rating per land use function
type
Industry Services
Rural
Urban
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
1
0
0
0
0
0
0
0
0
2
10
10
10
10
10
10
10
2
3
8
8
6
6
7
7
6
4
4
6
6
4
4
6
6
4
5
5
5
4
2
2
4
4
2
6
6
4
2
1
1
2
2
1
8
7
2
0
0
0
0
0
0
10
factor
Rating per land use function
type
Industry Services
Rural
Urban
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
1
0
0
0
0
0
0
0
0
2
10
7
8
10
10
8
8
1
3
9
8
10
9
9
10
10
2
4
8
10
9
8
7
9
9
3
5
7
9
7
7
6
8
7
4
6
6
8
5
5
4
7
5
5
7
5
6
3
4
2
6
3
6
8
4
4
1
2
1
4
1
7
9
3
2
0
1
0
2
0
8
10
2
0
0
0
0
1
0
9
11
1
0
0
0
0
0
0
10

Factor Weights

w1-land use atlas
w2-actual land use
w3-land tenure
w4-land capability
w5-life zones
w6-rainfall
w7-slopes
w8-land elevation

1
2
3
4
5
6
7
8

Weight per land use function
Industry Services
Rural
Urban
Natural Agriculture
Tourism
Forest
Quarries
Trade
residential residential
N
A
I
S
T
R
U
F
3
3
1
1
1
2
1
3
3
3
4
3
4
3
4
3
2
2
2
2
2
2
2
2
3
4
2
2
2
3
1
3
4
3
0
1
1
3
1
4
4
3
0
1
3
3
2
4
3
4
3
3
3
4
4
3
2
2
3
3
3
2
3
2

This table is a print-out of the Microsoft Excel Workbook SimLucia.XLS which has two
sheets: sheet 1 consists of the table above and features the factors and weights that have
been applied in the overlay analysis to produce the set of suitability maps used in
SIMLUCIA. In the left top corner of sheet 1 you will find a button named ‘Make
LucMac’. If this button is pressed, the Excel macro stored in sheet 2 of the Workbook
will be executed and produce the IDRISI macro named LucMac.IML. If you run the
latter macro in IDRISI, it will generate the set of suitability maps. Thus, with these tools,
you can change the factor types and weights and produce your own set of suitability
maps
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ANNEX D: Pointer Shapes

Pointer Shape

Description
Standard MS Windows Pointer Shapes
Standard Windows© cursor.
Standard I-beam cursor for editing windows.
Sizing cursor to change the width of the window. Displayed when the pointer
is on top of a vertical window border.
Sizing cursor to change the height of the window. Displayed when the pointer
is on top of a horizontal window border.
Sizing cursor to change the width and/or the height of the window. Displayed
when the pointer is on top of a window corner.
Sizing cursor to change the width and/or the height of the window. Displayed
when the pointer is on top of a window corner.
Context Sensitive pointer to get on-line help on the command you click on.

Specific SIMLUCIA Pointer Shapes
Insert cursor to insert values in an MBB-Dialog edit field by means of the text
value and table editor.
Insert cursor to insert values in an MBB-Dialog edit field by means of the
graph editor.
Insert cursor to insert values in an MBB-Dialog edit field by means of an
additional dialog.
Pen cursor to pick a value from the legend of a map and to enter it in a cell; or
to enter ordinal values in the X-Y graph part of the graph editor.
Bucket cursor to pick a value from the legend of a map and to enter it in a
group of contiguous cells.
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